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Introduction to IT
Support in Management

1.1.1 Concept of Data

Explain the term Data

A database is simply organised data. A database contains tables which are basically descriptions
of types of data. Table in turn contains records which is the actual data.

1. Data
2. Programs are nothing but gathering of instructions for altering the data.
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1.1.2 Information
Write .Mnmwlmon . : .
Information can be defined as data which is structured or which delivers lml.hmgmwb

=

1. Timely: Information should be given in time.
2. Accuracy: Information must preserve the accuracy.
3. Completeness: Information as to be complete.

1.1.3 Knowledge

Explain the term Knowledge
1. Knowledge can refer to an imaginary or realistic understanding of a subject.

2 meiedgecanbedeﬁnedaslmowingofmhgsbeforeitcanbenperimud.
3. Thingsmﬁg}nmwmngandﬂmtisdmidedmmwhaherammkmmwmw

know about those things.

1.1.4 Concept of Database

Write short note on Database
Datahasccanbcpmscntinm:myfonnssuchasitcanbeanumberortextwrimmuheetwit

can be as bits and bytes stored in electronic memory or as facts stored in a person’s brain.
1. Tables ,

2. Columns
3. Rows

Explain types and levels of Information System?

Information has become the cornerstone that connects the world. An information system is a
collection of components that work together to create information. Information system is

interconnected with data activity system. i3
1.2.1 Types and Levels of Information Systems
There are three main types of information systems.
There are five types of support systems.
1. Knowledge Management Systems

2. Office Information Systems
3. Business Intelligences Systems
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4.
5.

Management Reporting Systcnsmegemt Information Systems
tion S
Decision Support Systems e

The following are explained in detail:

5

Kn.o?vledge Management Systems: Knowledge Management Systems are meant to
fam:::te knowledge management in an organisation. As described in our approach and in
the knowledge creations cycle, they are only althou i

o part ( gh very important) of a knowledge
OlIIcf ll.lformati?n Systems: Office Information Systems provide information to the
organisation that is not directly available from operational support systems. Often, this is
wl data (e.g, office — documents or email), but it can also be a CRM (customer
relationship management) system.

Business Intelligence Systems: Business Intelligence (BI) refer to skills, technologies,
applications and practices used to help a business acquire a better understanding of its
commercial context. Business intelligence may, also, refer to the collected information itself.
Management Reporting System/Managements Information System (MIS): Management
Repor.ting Systems are intended to provide aggregate data about the performance of the
organisation. Usually, these are created from data generated by the knowledge or operational
layers of information systems.

Decision Support Systems: Decision Support Systems (DSS) are a specific class of
computerised information system that supports business. DSS is an interactive software
based system intended to help in decision - making compile. It useful information from raw
data documents, personal knowledge and business models to identify and solve problems
and make decisions. :

1.2.2 Computer Based Information Systems (CBIS)

Computer Based Information Systems is an information system in which the computer plays a
major role. Such a system consists of the following elements:

1.

3.

4.

Hardware: The term hardware refers to machinery. Parts which include the computer itself
which can be operated by central processing unit (CPU) and the hard disk can support all the
equipments like keyboard and output devices such as computer screen, storage devices and
communication devices.

Software: The term software refers to computer programs and the manual that supports
them. Computer programs are machine-readable instructions that direct the circuitry within
the hardware part of computer based information systems (CBIS) and gives the guidebook.
Data: Data are face that are used by program to produce useful information like programs
data are generally stored for computer need them. _ :
Procedures: Procedures are governed by the operation of a computer system. ‘Procedures
are to people what is the hardware and software’ it can deal with the function of a computer
system.

People: Every computer based information system (CBIS) needs people if it has to be useful.
People operate the computers.
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1.2.3 Types of CBIS
There are four types of CBIS.

1,

Executive Information Systems

2. Operations Support Systems

3. Transaction Processing Systems

4. Process Control Systems

The following are explain in detail:

1. Executive Information Systems: The Executive Information Systems (EIS) in detail; i ;

2.

type of management information system intended to facilitate and support the i

and decision-making need of senior executives by providing information of an organisagjoy,
It is Decision Support Systems (DSS).

Operations Support Systems: Operations Support Systems (PSS) give information @
products for internal and external use. They give specific information on products that gy
best be used by managers. Further processing by managements infu'mnﬁonmh
usually required.

Transaction Processing Systems: A Transaction Processing System (TPS) is a set of
information which processes the data transaction in the database system that monitors
transactions in a program (a special kind of program). These are usually database.

Process Control Systems: This includes a category of information system called process
control system in which decision and adjusting a physical production process is
automatically made by a computer. The computer monitors a chemical process capture and
process of data detected by the processes.

Explain success and failures of Information Technology?
It can be defined as success for IT projects and starts with planning.
Success is dependent on following factors such as:

g I e

o @

Good project planning

Communications focus on continuous connection with them
Profitability

Requirement cast quality time

Customer expectation

Good planning

Failure is nothing, but we can meet targets with the planning.
Failures is dependent on following factors such as:

1.
2. Customers dissatisfaction

3. Lack of communication =

Lack of clarity of objective
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1. Failure of Nike

Inoemx'nraailm&mofNik:'sAirTemHm!nmnhg:hoehitmejukpot.N&eis

famous for his golf equipment. When Nike decided to back off the golf
it e golf and bags, there were many

Skill set mismatch: Nike isalmrdtobelievebrmdmdoneofthebmdoﬂmmdllnmnhmin
the world. Except hardware devices Nike doesn’t fit in its expected skill set.

Bul,thareismoretoitthmgolfdeclinemdwhmyoutnkeampmmdlooknit,the
programme makes all the sense in the world.

With club sales declining and interest in golf normally getting slow, Nike had take to
decision to focus on apparel and shoes. 4 y e

2.AT&T

Later on as upgrades came, it failed in providing fast speed of network to customers.
It was ranked the fastest 3G network in some wireless surveys.

A CRM system at AT & T wireless that was upgraded in 2003 to improve customer care crashed
during the upgrade.

AT & T system had gridlocked the customers service phone system.

Every cellular network has its troubles with voice quality, irregular failed calls and unsatisfactory
data.

Major areas of IT Applications in Management

There are five major are as of managements that are listed below:
1. Inventory Management

Human Resources
Customer Relationship Management
Productions Management
Finance Management
(a) Investment policies
(b) Method of financing
(c) Dividend decisions
1. Inventory Management
When it comes to managing inventory, organisations need to maintain enough stock to meet the
demand without investing more than they require.
This system is best used when the inventory management system is connected to the point of sale
(POS) system.
Inventory management system tracks the quantity of each item a company maintains, triggering
an order of additional stock when the quantities fall below a predetermined amount. J

A e O
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2. Human Resource Management

The purpose of personal managements is to generate and encourage team strength
anploymtmdmmaseﬂ.

Hmmmnmmstmeﬂt is worried with achieving and preserving ﬁmw

fulfilled effort force.
It is a dedicated of managements apprehensive with human managements.

The recruitment appointments’ training point of references and encouragement of employeeg -

incorporated by personal managements.

3. Customer Relationship Management
Companies are using ITtoimprovethewaytl'leydesign and manage customer relationships,
Customer Relationship Managements (CRM) system capture every interaction a company pag

with a customer so that a more enriching experience is possible.
’I’hecustomerhasabate:andnwwfocusedcxpu'imandthecompanybmeﬁtsﬂ'omhmw

productivity.
4. Production Management
Sometimes pay for and catalog managements are treated as part of productions management.

Production management can contain the roles listed below:

(a) Guarantee efficient production control

(b) Construction system and equipment

(c) Managing purchase and luggage compartments of material
(d) Place position layout and continuation

(¢) Product preparation and continuation

5. Finance Management

Financial management contains primarily three decisions:

(a) Investment Policies: It states the procedure related to making financial arrangements and
expenditures, Each and every application to use currency is positioned and investment
decisions are taken whether to approve money for these proposed undertakings or not.

() Method of Financing: An appropriate blend of small and long-term financing is guaranteed

in order to supply required fund for planned undertaking at a minimum amount of danger to

the enterprise.
Dividend Decisions: This decision has an effect on the total paid to shareholders and

©
sharing of added shares of stockpile.
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What is Digital Economy?

Digital economy or_ﬂgc group of economic procedures and forces of creations that work together
with digital economy. Digital economy or the internet economy is increasingly influencing our social
and economic activities and even the way we live,

Digital economy is an umbrella term used to describe markets that focus on digital technologies.
It refers to the full range of our economic, social and cultural activities supported by the internet and
related information and communications technologies, These typically involve the trade of information
goods or services through electronic commerce,

Advantages of Digital Economy

1. Cashless transactions are only possible with white money which renders the black economy
untenable.

2. Blackmoneyisamajorprobleminlndiaandmefactﬂm\lessﬂunSpucmtofall
payments in the country are made electronically has not helped the matter.

3. Cashless transactions can be easily monitored by the government which will enhance
revenue collection, and consequently increase the funds to carry out development activities.

4. The expenditure incurred by the RBI in printing notes would be considerably reduced.

5. IntheyearZOlS,theRBlspcnt?Z?biJlionMMgmdmnagingmymtes.

6. The citizens would no longer have to carry liquid cash with them.

Disadvantages of Digital Economy

1. 'l‘hesmnllretailersinlndiadealmﬂyincashandhavcnotbemabletoﬁ:min_thedigim]
infrastructure.
2. Many poor people do not have bank accounts.

3. The taxes surcharge and the fees charged on digital transactions need to be made liberal, in
order to encourage the people to adopt the practice.

4. The public would not be willing to move towards a cashless society.

5. The Indian public is not much educated with regards to the benefits of using card or online
payment methods.

6. A vast majority prefer using cash as a convenient method of payment.

Explain the term: Digital Organisation
e Digital is a mindset. As the digital time but what does this actually signify for the
organisation?
If it does not perform any task, then it simply doesn’t work.
The digital technology forms integral part of a digital organisation.
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sation that meamchnologyaucompa&tiveadvmhh :

° Ad]sinlmtu]ﬁxiamﬂ?mi
internal and external operations. g "

]. Acquire capabilities

2. Risk-taking ‘

3. Challenge everythms_
Following are gxplnmed in detail: .

cquire ca bilities: The skills required for digital MMM pu:obably can't pe
1. ;-oomd mﬁl:»:ly from within, The acquisition enabled Tesco to quickly build up the skillg i

needed to move into digital medium. .
Risk-taking: This will help organisations to improve their performances, be eager to take

mﬂedﬁsksmdbcwmfomblemexperﬁncnﬁng.

s It inci ing themselves comes from sil;
3. Challenge everything: It is no coincidence that redefining : silicon
valley, the epicenter of digital disruption. The leaders of incumbent companies

aggressively challenge the status quo rather than accepting historical norms,

ARowees oo U

1.7.1 Open-source Software
The term “open-source” refers to something people can modify and share because its design is

2

publicly accessible.
It is a software having the source code in which each and everyone can examine, alter the content,

improve and share with anyone without having a license.
Unix operamg system is an example of open-source system.

1.7.2 Open-source Software/Application

There are four types.

1. WordPress

2. Mozilla Thunderbird

3. Multimedia

4. Browsers

Following are explained in detail:

1. WordPress: WordPress is the world’s most popular blogging platform used by a staggering
202 million websites. The WordPress magazine theme to portfolios using WordPress gallery
themes are great for photographers’ and designers’ creations in an online portfolio.

2. Mozilla Thunderbird: With its speedy searches, built-in RSS feeds, strong security and
superb add-ons thunderbird has to be the best free email application available. If you are
prepared to spend some time tailoring your email environment with add-ons then you will
absolutely love it, but probably not ideal for complete novices.
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3. Multimedia: MediaCoder is a free of charge worldwide batch media transcoder which

fm‘bincs popular audio:'vide_o codes and tools into a single solution. The media player VLC
is a transportable multimedia player, encoder and streamer underneath many audio and

video file formats as well as digital versatile disk video com disk. Basically, it can
beautifully play whatever you give to it. e .

4. Browsers: Mozilla Firefox
It includes tabbed browsing, a spellchecker, in
manager and an integrated search system.
Morzilla Firefox is a free of charge and
popular browser in current use worldwide,

Explain Windows Operating System

cremental find, live bookmarking a download

open-source web browser. It is the second most

Every gmera!wrpose computer must have an operating system to run other programs. The
operating system is the most important program that runs on a computer. For large systems, the
q,cmﬁngsystanhaswengrmtermponsibiliﬁesmdpomItislﬂ:eatraﬂiccop.ltmakamﬂm
different programms and users running at the same time do not interfere with each other.

Operating system can be classified as follows:

1. Multi-user: Some operating systems permit hundred or even thousands of concurrent users.

Real-time: This type of operating system responds to input instantly. The are operating
system to as DOS are not real time. :

3. Multiprocessing: They are running more than one program in the CPU.
4. Multitasking: This system allows to run one or more than one program at a time.

Functions of Windows Operating System

1. Network: It can give information of any new network or program which is connected or
disconnected. It can give graphical representation on the network resource usage by the
computer.

2. Services: Services can be operating system and there are display the services which has
preformed their operations or the services that are performing operations.

3. Task manager: When you open any application, for example there is paint then status of
paint is displayed and the applications tab is the task manager.

If any window is operating then that is also known as the task manager.
Application can be give the informing to the widows about the process which are the
operating system.

4. CPU: CPU usage is nothing but how much CPU time is used. It can use to check the CPU
consumed by an individual process.
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unuxwoneofdwpopularvemmsofoperanngmtem.ltwanopen-mceum ‘,
casily available for modification. Source .

Disk Operating System
Diskopmtﬁxgsystemisanapmﬁngsystemwhichismedbyasinglemer,mﬂmbﬂ
into multi-user environments.
Mmmsﬂﬂthecompﬁutlmthednskopmﬁngsymmstartsworlmginmgw
the computer such as read only memory, random access memory and peripheral devices,
Features of operating systems are as follows:
1. It can accept characters.
2. Itis a help to the management.
3. It can use only single operating system.

Fill in the blanks: vy

L refers to the application of computers and communication technology to Dmm;

2. TPS stand for

3. DOSis system.

4. are information system that use a of b
o sym sys variety of information tochnology to hdpm |

5. lslmnsporlable multimedia player.

6. Database system is of database and database managements system.

Q2. True or False:

MIS is based on internal information flow.

Disk operating system is single use.

DOS stands for disk operating system.

Digital economy is a superset of digital market.
WWWWWMWMWWmmm

Q3. Match the following:

LT - PR S

Group A Group B
1. Digital economy | (a) Computer program
2. Software (b) Spellchecking
3. Information (¢) Group of economy procedure
4. Word processing | (d) Processed data

Q.4. Write short notes:
1. Digital economy
2. Disk operating system
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IT support system

Information system

Transaction Processing System
Management Information System
IT Applications operating system

Long answers questions:

Explain the database information.

Explain the levels of information system.
Explain the different types of IT support system.
Explain the Management Information System.
Explain the operating system.

LRk




Office Automation Using
MS-Office

e gy L N e e MO Ve SRR e My

It is developing Microsoft Office.
It can create and save professional documents.
The example is a letter and report.

2.1.1 Creating Documents
1. This helps in creating a document.
2. Itis a blank document.
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3. For new document, we can select new.
4. The blank document is under section blank and recent.

2.1.2 Saving Documents

1. Microsoft Office can save documents.
2. In Microsoft, there are “save” and “save as” options provided.

3. If you are typing any data and you do not save the data then the computer can lose the data
or the document.

4. So, at the time of typing you can save the data or the document.
5. Following are the pointers:

(a) open the new document in Microsoft word.

(b) after adding the data the document can be located at the top.

2.1.3 Introduction

* |[8| Instated Tempiates
My templates..,

New from existing

Featured
Agendas
Award certificates

In addition to working with existing documents, you will want to be able to create new
documents. Each time you open Word, a new blank document appears; however, you will also need to
know how to create new documents while an existing document is open.

In this lesson, you will learn how to create new documents - including templates and blank
documents — via the Microsoft Office button,
2.1.4 New Documents
To create a new blank document:
e Click the “Microsoft Office button™.
e Select “New”. The New Document dialog box appears.
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e Select “Blank document™ under the “Blank and recent” section. It will be highlighteq ol

default.

New Document

Installed Templates

My templates...
New from existing...

TN,

4

Newsletter wizard Equity Resume
— e

¢ Click “Create”. A new blank document appears in the Word window.

You can access templates that are installed on your computer or on Office Online. Click the

“Microsoft Office™ button and select “New”. You can create blank documents and access templates
from the dialog box that appears.

To save a Document in Microsoft Word, please follow the steps below:

Microsoft Word is a word processing program that allows you to draft your own documents like
essays, letters, resumes, etc. It is not uncommon for online instructors to request you to turn some
assignments in the form of a Microsoft Word document. There are a couple of advantages to using
Microsoft Word for submitting work.

l. You are able to save your work as you go along (which is nice, in case, blackboard and/or

your internet experience problems when submitting your work).

2. Your instructors are able to check the formatting of the document (because the formatting of
your work does matter in some courses).

In Microsoft Word...

1. Type and format your document as required for your course work.

2. When work is ready, click “File’" at the top left of the menu bar. Then, scroll down and click

on “Save As”. (The example below shows a short drop-down menu under the “File” option;
yours may be longer, but the “Save As” option is still the choice to select.)

J
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4. In the “Save As” dialog box, click the drop-down arrow to the left of the “Save in” option to
select the appropriate place to store your file. Then, in the “File name” box at the bottom of
the dialog box, type an appropriate title for your work, being sure to include your name
somewhere in the title (this is helpful for your instructor to keep up with whose work is
whose). Then click “Save”,

6. Your file is now saved. The saved file name should now appear in the left corner in the blue
strip at the very top of the screen.

(Be ER Yew Juwt Fgmet ok Tt Window b Fyce i vl
LEEH3gaa?7n v vy 9-o- AoanE aF o~ -0 wes
A Nermal ~ Tomes Mow Roman - 12 - l-fl""-ﬂfEE#C'B-"-A'I

A —— - v L BB mmn-EE AR

v o0 b0 o ORI 2roesgens R A R N R e A

(L]

My-document-is-typed-and-formatted-just-as-my-instructor-wishes -I-am-nowready-o- save-and-
submit-my-work |
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. To close Microsoft Word, cither click “File" and then “Exit” o the drop duwn mepy
: ‘Exn”ismtanopﬁmonyom'mcnu,cﬁckﬂrdoublcmowatﬂnboamnofthe
“x” box at the top right of the screen.
9.
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2.1.5 Edit Features

Map authors build their maps to include the layers and configurations needed to achieve the
purpose of the map. When one of the purposes of a map is to gather community or organisational input,
the map author includes editable feature layers in the map. For example, an author might include an
editable feature layer that allows the birding community to post their bird sightings directly on the map
and attach media files — such as photographs, audio files, and video files — to the specific observation
points. Because these features are part of the layer, any changes made to the layer in the map are
immediately viewable by everybody who has access to the layer, even when the layer is part of a
different map.

The publisher of the feature layer or the administrator in your organisation decides whether a
feature layer is editable and sets an editing level. Editing levels determine whether you can
features only, update feature attributes only, or add, update, and delete features.

If the feature layer is editable and you have privileges to edit features, you can open a m
containing editable features in MapViewer or add an editable feature layer to MapViewer to edit |
features.
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Wer are automatically saved to the layer; there is no save button to click.
When you add, deletc,wedna&annewmhuandrealiseyoumdnanﬂsmyoumcliCk
“Undo” to delete your edit.

The following steps describe how to edit a feature layer in MapViewer.

1. Open the map in MapViewer that contains
feature layer in a new map.

2. If necessary, check the box beside the layer you want to edit, and click “Edit”.

Theeditasu_:ttingsmthc layerdetmninethetypeofedhsyuumpafm If the layer
nq:pomacﬁmgfemres,meditthmphmappeanmme“AddFm”mmﬂwleﬂ
side of the map. Templates are shown for each fennu'elayq-inthemaptimmpportsadding
features. The layer publisher defines the templates, which provide predefined styling and
other settings based on feature categories. Using bird sightings as an example, a layer owner
might create different templates for broad categories of birds such as raptors, songbirds, or
shorebirds.
3. Follow these steps to add a feature: :
(a) Choose a feature template for the layer from “Add Features”.

(b) thnaddingapolygonorlimfeahmthatneedstoaliguwithorjointocxisting
features, press the “Ctrl” key to enable snapping. :

(¢) Click the location on the map where you want to add or draw a feature. If you are using
smpping,conﬁnucwprmd:c“cm”kcywhﬂechwmthenewfeaumtobep
snapping to the nearest existing feature. '

(d) Whenyouﬁnishaddhxgttnfm&mapup-upappwstoallowwutomnﬂed}e
attributes for the new feature. The fields available are unique to the layer. For each
attribute, type a value that is relevant to the new feature.

For the bird sightings map example, you might type the bird species, whether it was male or
female, its approximate age (fledgling, juvenile, or adult), and the date and time you saw the bird.

theﬁatm'elayerymmmtoedit,oropmdn

2.1.6 Designing a title page, Preparing Index
Microsoft Word makes it painless to create a professional cover page.

The Office suite comes with a few well-designed cover pages that you can re-purpose for your
document. There’s a good variety to choose from.
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T
Austin lon(Light)
R LR ol :
—_—
- FAB =] |~
Filigree Grid Relrospect Semaphore Sideling
Open a new Word document. Click on the “Insert” menu on the ril?bon. The dmp-down for
“Cover Page” is the first feature you will spot on the menu (under Pages). Click on the tiny amow next
to it and open the inbuilt gallery of templates. Pick one from the 16 preformatted templates and three
more on “Office.com”.
{ Home Insert Design Layout References Mailing:
WESESE ) [ (] D /2 Bismaan .
. Y |
| % [————] .
| |
! | ]
1 . _
| ez 1/ L1 |
II —
: Austin Facet
| = I
'j “‘:_-:-Iul j
|I v ‘4
|
_ Filigree S TS integral -
|ﬁ More Cover Pages from Office.com »
r B( Remove Cument Cover Page
| ﬂ{ save Selection 1o Cover Page Gallery

Select the one you like and click on it. The cover page appears at the beginning of the
by default. But to place it in any other location, right-click on the cover page thumbnail in the
and select from the options given. Though, am not sure why you would want to!

A

20
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PRV ) ] I
e

Insert at Beginning of Document
Insert at Beginning of Section
Insert at End of Section

Insert at End of Document

Edit Properties...

ViewMaster

Organize and Delete..,
Add Gallery to Quick Access Toolbar

2.1.7 Customize Individual Fields

Click on each preformatted field (the square brackets) and the whole thing gets highlighted with a
blue field label on top. Type in your version for the given field. The author name might appear by
default if the Office installation is in your name. Place the common information in “Quick Parts” and
you don’t have to bother with typing them again and again.

ABSTRACT

[Draw your reader in with an engaging abst:-
typically a short summary of the document.
you’re ready to add your content, just click ©
start typing.]
[2Authar |
|Sajikat Basu
[Course title]

Change the date fields with the drop-down arrow and select a date from a calendar. You can
format all fields just like normal text.

2]
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[COMPANY NAME]
_[Company address]

e ——

4 February 2017 b
| Su Mo Tu We Th Fr 5a |
| 20 20 31 + 2 8§ & |
s 6[7 8 9101 |
' 42 13 14 15 16 17 18 |
| 19 2021 2 23 M4 B |
o TS 2 2 8

4M 11

F";'_—“
| Today |

You can easily edit graphical cover page elements like any ot{ler image. Just click on the graphic
to display the “Drawing Tools” and “Picture Tools” menus on the ribbon.

(e

ob Cut
Ba Copy
Qy Paste Options:

G

Edit Pacture

rf_: Bring to Front

n‘,g Cend te Back

8 Wnaplet
| I1 Sge and Posibon... J
| & Format Picture... B 1

Changed your mind about the entire cover page? While working on one cover page, you can
change it for another cover page by selecting a new template from the drop-down. The new template

retains the field entries.
Note: 7o replace a cover page created in an older version of Word, you must delete the first cover page manually,
and then add a new design from the cover page gallery.

22



@ Automation Using MS-Office 21|

Click on “Save” to finalise the cover page as a document.

If you would like to save the cover page for later use in another
page. Click on “Insert” > “Cover Page” > “Save Selection to
same menu to remove a selected cover page from the gallery,

document, select the entire cover
Cover Page Gallery”. You can use the

mw
_—

Filigree Gnd Integral

Mere Cover Pages from Office.com

[5x Bemove Cument Cover Page
(R Save Selection to Cover Page Gallery..
Microsoft Word templates are a time-saving soiution, but they don’t allow your personality to
shine through. To add a personal touch, you should put in a bit more effort and make a thoughtfully
designed cover page from the scratch.

2.1.8 Design Your Own Cover Page

You have all the image editing tools in Microsoft Word at your disposal. When you can design

your own logo in Microsoft Word, a cover page is less of a chore. Borrow or steal ideas from the
process.

The screenshot below displays a cover page I created in Microsoft Word from the scratch. I used
a few basic “Shapes” to create the design and formatted them with colour.
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Enter the details in the dialog
Microsoft Word elements that you can

dialog box looks like:

Meme  [MyPeronsl CoverPoge ,_

box for a new building block. Builfling blocks are
addtoanyofthegalledesavailablcmwm Tlnaiswh.gh -

| —
M [;éwm. ————————— |
A custom made cover page template. |
|
gweln | Builing Blodks j ;

= ]

gotons: e contentow 9] |
Name: Give the cover page a name. ’ 4
Gallery: Choose “Cover Pages” from the drop-down.
Category: Choose a category. For better organisation, make a new category. !
Save in: Save it in your template or in the building block. When saved as a building block,
you can use it in any Word document without opening the template.

Click “OK” and close the Building Block dialog box. Go to the “Insert” menu and check your
new cover page template.

My Covar Pages

e o o o

A custom page cover page 7 l

)
More Cover Pages from Office.c@

[x Remove Cumrent Cover Page
Ei; Save Selection to Cover Page Gallery...

2.1.9 Use of SmartArt
Applies To: Excel 2016, Word 2016, Outlook 2016, PowerPoint 2016, Excel 2013 ...

Create a SmartArt graphic to quickly and easily make a visual representation of your information.
You can choose from among many different layouts, to effectively communicate your message or
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For an overview of SmartArt graphics, including considerati i graphi
: ons for choos
layout type to display your data or convey a concept, see Choose a Sm::tArt g:;:lgn?e ¥ i
In this article
Insert a SmartArt graphic and add text to it.
Add or delete shapes in your SmartArt graphic.
e Change the colors of an entire SmartArt graphic,
e Apply a SmartArt Style to a SmartArt graphic.
Insert a SmartArt Graphic and Add Text to it
1. Click on the “Insert” tab, under the “Illustrations” group, click “SmartArt”,

. Insert | Design Layout References

B E @ =N lll
Table Pictures Online Shapes Sn 1

. . Pictures -~ S
Tables Illustrations

2. Inthe “Choose a SmartArt Graphic” dialog box, click on the type and layout that you want.
3. Enter your text by doing one of the following:
e Click on “[Text]” in the text pane, and then type your text.
e Copy text from another location or program, click “[Text]” in the text pane, and then
paste your text.
Notes:

o If the text pane is not visible, click the arrow control on the left side of the SmartArt graphic.

e To add text, like a title, in an arbitrary position close to or on top of your SmartArt graphic, on the “Insert™ tab,
under the “Text” group, click on “Text Box™ to insert a text box. If you only want the text in your text box to
appear, right-click your text box, click “Format Shape” or “Format Text Box”, and then set the text box to have
no background colour and no border.

e Click on a box in the SmartArt graphic, and then type your text. For best results, use this option after you add
all of the boxes that you want.

Add or Delete Shapes in your SmartArt Graphic
1. Click on the SmartArt graphic that you want to add another shape to.
2. Click on the existing shape that is located closest to where you want to add the new shape.

3. Under “SmartArt Tools”, on the “Design” tab, in the “Create Graphic” group, click the
arrow next to “Add Shape”.
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- Home Insert Design Layout

171 Add Shape aﬁ(- Promote T Move Up
‘= Add Bullet = Demote ¥ Move Down

ET] Text Pane 8 Right to Left s Layout -

Create Graphic

If you don’t see the SmartArt Tools or Design tabs, make sure that you've selected the SmartAy
graphic. You may have to double-click the SmartArt graphic to open the “Design” tab.

4. Do one of the following:
e To insert a shape after the selected shape, click “Add Shape After”.

e To insert a shape before the selected shape, click “Add Shape Before”.

Notes: :
® Toaddashapefmmlhethpmc,clickmaitﬁng:hnpe,mweymnmbefmeouﬂerﬂummm j
want to add the shape, and then press “ENTER". vl
e To delete a shape from your SmartArt graphic, click the shape you want to delete, and then press “DELETE",
To delete your entire SmartArt graphic, click the border of your SmartArt graphic, and then press “DELETE”,

¢ To add a shape like a callout or a line, see “Add Shapes”.

L

Change the Colours of an Entire SmartArt Graphic
You can apply colour variations that are derived from the theme colours to the shapes in your
SmartArt graphic.
1. Click on your SmartArt graphic.
2. Under “SmartArt Tools”, click on the “Design” tab, in the “SmartArt Styles” group, click

3
M€ r

Change |
Colors ~ £

“Change Colours”. _
SmartArt Tools
| Design | Format Q Tell
i | g s
oo FF - - |

SmartArt Styles

Ifyou don’t see the SmartArt Tools or Design tabs, make sure that you've selected a SmartArt
graphic. You may have to double-click the SmartArt graphic to open the “Design” tab.

3. Click the colour variation that you want.
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1. Click your SmartArt graphic,
2. Under “SmartArt Tools”, on the “Desion™ tab. i 2 g \
SmartArt Style that you want, = » I the “SmartArt Styles™ group, click on the

Note: To resize your entire SmartArt graphic, click the border of

handles in or out until your SmartArt your SmartArt graphic, and then drag the sizing

graphic is the size that you want.

they will be taken to another place,itoouldbctoﬂmﬂlerlopic,nboohmrkinmﬂtawpic or to an
external website, '

On the other hand, a cross-reference functions in the same way when clicked, it will navigate the

user to another location. However, one caveat is that it only allows linking within a MadCap Flare
project. So, why use a cross-reference over a hyperlink? '

Hyperlinl.:s are great for when you are linking to an external location, such as a website or a
location that is outside of your Flare project. However, the issue with hyperlinks arises when you
begin to think about how this will nffecttheuscrcxperimcewhmmtingnwinmdvmion of the
output.

Enter the Cross-reference

Cross-references have the advantage of dynan'licﬁlly changing based on your output types. For an
online output, a cross-reference might look and feel just like a normal hyperlink. However, when
going to a print based format, the cross-reference will update and show you where the linked element

is contained on the printed page. Some examples might be “On the next page” or “On page 24”. So,
cross-references can be context-sensitive and will let the user know where the referenced content is in
context. Also, if the print output is being viewed electronically on a screen, they will still behave like

hyperlinks and allow users to click on the item and take them to the content,

Quick: If you already haveyourfonnatset@themyyouwmit. you can use the quick cross-
reference method, which is faster but does not have as many options. This method lets you quickly

select a bookmark that may already exist in the current file, a file in the same folder, or another file
currently open.

Standard: You can use the standard method, opening a “cross-reference” dialog box that
provides additional options for selecting styles, properties, and link destinations. There are four
different ways to insert a cross-reference:

1. Right-clicking in the editor then going to “Insert” > “Cross-reference”

2. Using the insert ribbon: “Links” Section > “Cross-reference”
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3. Using the local toolbar of the editor:

!ﬁwm—m(um-ngeuyuut-m!aﬁ-i!-@@-'@@w‘;ﬂ

4. Orifyou love keyboard shortcuts, use “Ctrl”

+ “Sh.iﬂ‘” + HR‘H:

Link to:

 [Topenprojec vl

09 @ [@ | § | Topic Files ("htmy’ ~

R ok
Twvwvwevevw

OEEEELERE
0000000

T

One advantage of the standard method is that you can select the “Bookmark” icon, easily located
in the cross-reference dialog box. This will allow you to select elements within your topic to cross- °
reference to and a bookmark will automatically be created, as shown in the dialog box below:

e — R T e My
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2.2.1 Maintaining Cross-references

One thing to note: If you insert a cross-reference into a topic and later make changes that affect
the cross-reference, you might find that it isn’t pointing td the correct place. _

Example: I create a cross-reference to a heading and later decide to change the title of the
heading. The cross-reference won’t automatically update in the editor. However, these will
automatically be taken care of at compile time and will display the correct reference title in the
generated output.

However, Flare has the ability for you to update cross-references in a topic so that you can spot
check whether the cross-references are linking to the appropriate content. You can do this by taking
the following steps:

1. Open a topic.

2. Select “Tools” > “Update Cross-references”, and the “Update Cross-reference” dialog opens,
displaying the destination topics of your cross-references.

3. Click “Update” > “Save”. .
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. — i bunch of content that already
links? Maybe you're importing a .
lwpalmluM h;\':,; bmhmd(‘.n;f:nyrfyrmr to run a cross-reference suggestion report and use Analyzer %
m)’ convert those hyperlinks to cross-references!

Cick Update' to update all selected cross-references.

Update Cross-Reference Link

MadCap Central  |Topichtm

1

- —

Updating cross-references is not a mandatory step. When you generate output for a target, all

ofmmmwbemdntadmﬂcdy. However, you can use this feature to
# mﬂymﬂahm&mhammﬁhhamdmrwﬁdﬂ‘
mammuutmmumwmmmmm

-
.

the entire target.

Cancel

T

A bookmark is a saved shortcut that directs your browser to a specific webpage. Internet Explorer
uses the name “Favorites” to refer to bookmarks, like Safari, it displays all your favourites in a list
within the browser window.

All major web browsers allow you to create bookmarks, though each browser provides a slightly
different way of managing them. For example, Chrome

and Firefox display your bookmarks in an
open window, while Safari displays them in a list in the sidebar of the browser window, Internet
Explorer uses the name "Favorites" to refer to bookmarks, and like Safari, it displays all your
favourites in a list within the browser window sidebar. '

To create a bookmark, simply visit the page you want to bookmark and select, “Add Bookmark”
or “Bookmark this Page” from the Bookmarks menu. In Internet Explorer, you can click the star icon
to open the “Favorites” sidebar and click “Add to Favorites” to add the current page to your
bookmarks. The website title will show up in your bookmarks [ist along with the website's icon, if
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available. As your Oqllecﬁon of bookmarks grows,
into different categories,

It is helpful to boolnnark frequently visited websites and useful references since you don't have to
remember the URLs. Additionally, you can just click the bookmarks instead of typing in the full web

addresses. Some browsers even display your bookmarked pages in the Autocomplete drop-down menu
bookmarked pages without even opening the

as you type in the address bar. This allows you 1o visit
bookmarks window or the sidebar in your browser,

Note: A bookmark only stores the location of a webpage, it does not store the contents of the webpage itself.
Therefore, when you open a previously saved bookmark, the contents of the page may have changed since the
last time you viewed it.

Select the text or the image tlmtyouwanttouseasthedutinationforthehypalink. Click the
Insert tab. In the Links group, click Bookmark. In the Bookmark name box, type a unique name for the
bookmark, and then click Add.

How do I turn off automatic hyperlinks?
To turn off automatic hyperlinks, follow these steps, as appropriate for the version of Word that
you are runmning:
e InMicrosoft Office Word 2010 and 2013, follow these steps:
1. On the File menu, click Options,
2. Click Proofing, and then click AutoCorrect Options.
3. On the AutoFormat as you type tab and on the AutoFormat tab, click to clear the

Internet and network paths with hyperlinks checkbox, and then click OK.
4. Click OK to close the Word Options dialog box.

e In Microsoft Office Word 2007, follow these steps:
1. Click the Microsoft Office Button, and then click Word Options.
2. Click Proofing, and then click AutoCorrect Options.

3. On the AutoFormat as you type tab and on the AutoFormat tab, click to clear the
Internet and network paths with hyperlinks checkbox, and then click OK.

4. Click OK to close the Word Options dialog box.
¢ InMicrosoft Office Word 2003 and in Microsoft Word 2002, follow these steps:
1. On the Tools menu, click AutoCorrect Options.

2. On the AutoFormat as you type tab and on the AutoFormat tab, click to clear the
Internet and network paths with hyperlinks checkbox.
3. Click OK.

How do I change the display text or image of a hyperlink after it has been created?

You can change the display text or image for a hyperlink in the same way that you edit any text
or image in your document.

To follow a hyperlink, press and hold CTRL, and then click the hyperlink.

Yyou can create folders to organise your bookmarks

31
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For more information, click the following article number to view the article in the Microsof
Knowledge Base:

279090 Cannot click to activate hyperlink

How do I remove a hyperlink without losing the display text or image?

To remove a single hyperlink without losing the display text or image, right-click the hyperlink,

and then click Remove Hyperlink.
To remove all hyperlinks in a document, press CTR

press CTRL+SHIFT+F9.
Note: Performing this operation converts all fields, not just hyperlinks, to plain text.

How do I change the underlying Uniform Resource Locator (URL) for a hyperlink?

To change the underlying URL for a hyperlink, follow these steps:

1. Right-click the hyperlink text or image, and then click Edit Hyperlink.
2. In the Edit Hyperlink dialog box, type or select a URL from the Type the file or webpage

L+A to select the entire document and thep

name box.

3. Click OK.
How do I create hyperlinks to locations within the same document?

To create a hyperlink to a location within the same document, use one of the following methods:

e Use a drag-and-drop operation. To do this, follow these steps:
1. Save the document.
2. Select the word, phrase, orunagematyouwanttouseasthedeshnauonforﬂm
hyperlink.
3. Right-click and hold down the mouse button while dragging the selection to the new
location; then, release the mouse button.

4. Click Create Hyperlink Here.
e Create a bookmark, and then create a link. To do this, follow these steps, as appropriate for

the version of Word that you are running: _
¢ In Word 2007, and in Word 2010 and 2013, follow these steps:

1. Save the document.

3 Selectthetextartheimagethatyouwanttouseasthedesﬁnationforﬂ:ehypwlink. r

2
3. Click on the Insert tab.

4. In the Links group, click on Bookmark.

- $ indd.theBookm:kname box, type a unique name for the bookmark, and then click
6. ::vh;:: hzzatzon point to the location in the document where you want to create
7. Click Hyperlink in the Links group.

8. Click Bookmark.
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10. Click OK to close the Insert Hyperlink dialog box.
¢ In Word 2003 and in Word 2002, follow these steps:
1. Save the document,

2. Seloctﬂaetextortheinmsetimxyouwnmtouseumedesﬁmﬁonforﬂwhyperlilﬂa
3. On the Insert menu, click on Bookmark.
4

: lixd:\eBooknmkmmebmgtypeamiquemmeforthcboohmk,mdthencﬁck

5. Move the insertion point to the location
~ the hyperlink.

6. In the Insert menu, click on Hyperlink.
7. Click on Bookmark.

8. In the Select Iflace in Document dialog box, select the bookmark that you want to
use as the destination hyperlink, and then click OK.
9. Click OK again.

What is the difference between a relative hyperlink and an absolute hyperlink?

An absolute hyperlink uses the full address of the destination document. A relative hyperlink uses

the address relative to the address of the containing document. This is also known as the hyperlink
base.

For example, suppose that a document has the following address:
C:\My Documents\1999 report.doc 5

This document has absolute and relative hyperlinks to a document that has the following full
address (and absolute hyperlink): :
C:\My Documents\April\Sales.doc

The relative hyperlink contains only the relative address to Sales.doc. The relative address is as
follows:

April\Sales.doc

Use a relative link if you want to move or to copy your files to another location, such as a web
server.

When I click on a hyperlink in Word, I receive a message that indicates that no program is
registered to open the file. What do I do to open the file?

You receive this message when Windows is unable to find the program that is associated with the
type of document that is specified in the hyperlink path. This information is encoded in the extension
of the hyperlink address.

To view the hyperlink, turn on the Tool Tips option, and then position the mouse pointer over the
hyperlink. :

in the document where you want to create
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To locate the Tool Tips option, use one of the following procedures, as appropriate for the

version of Word that you are running:

o In Word 2010 and 2013, click File, click Options, and then click Display.
e In Word 2007, click th¢ Microsoft Office Button, click Word Options, and then cljck

Display. |
e In Word 2003 and in Word 2002, click Options on the Tools menu, and then click the Viey,

tab.

This paragraph contains information about using the Remote Mail feature in Microsoft Exchange,

Note: Microsoft Exchange is not included in Windows 98. If you upgrnde a Wmdom 95
installation in which Microsoft Exchange is installed, Microsoft Exchange is available in Windows 98,

2.5.1 More Information

You can use Microsoft Exchange to log on to a remote mail system using a modem or LAN angd
view the mail waiting on the server. You can then download the mail, download a copy of the mail
and leave a copy on the server, or delete the mail on the server. This feature was primarily designed
ﬁrnmbﬂecomptmmerswhoreﬁevemailﬁ'mnhomcandwoﬂc,btncanalsobensedmyﬁmgym
want to see your messages before downloading them. Note that not all Microsoft Exchange
information services have the ability to use the Remote Mail feature.

2.5.2 Preparing Your Computer for Remote Mail

1.
2.

-

2.5.3 Specifying Configuration Options for Remote Mail

L.
=
3.

Install Microsoft Exchange and the appropriate information services (for example, internet
mail or Microsoft Mail) on the computer you will be using for Remote Mail.
IfyouplanonusingRemoteMailwiﬂaamodem,insta]lthemdemandcreateaDial-Up
Networking connection to the network your mail server is on. i
Make sure that you do not have Microsoft Exchange running on another computer and
downloading mail from the same server. If you do, that computer may continue to download
messages and remove them from the server.

Quit Microsoft Exchange. ,

In Control Panel, double-click on “Mail And Fax”.
Click the information service with which you want to use Remote Mail, and then click on
“Properties”. ]
Select the options you want to use. For information about an option, click “Help”. When yo
are done, close the property sheet and restart Microsoft Exchange.
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2.5.4 Sending and Receiving Mail Remotely

1. Start Microsoft Exchange on the computer configured for Remote Mail,

2. Compose messages as you normally would. When lick “Send”, composed messages
are placed in the Outbox to await delivery, SR

3. On the Tools menu, click “Remote Mail", 1f more than informati i
\ on is
configured to use Remote Mail, click the service you want to use, ' R

4. On the Tools menu, click “Connect And Update Headers”, If

messages waiting on your server in the Remote Mail
window *

For each message, you can click “Mark To Retrieve”, “Mark To Retrieve A Copy”, or
“Mark To Delete”. You can mark a message by cli

_ cking the message and then clicking the
oanmandyouwanttomemtheEd:tmenu,urbymingtherightmbusebuttontoclickﬂle
message and then clicking the command you w.

. ant to use on the menu that appears. The
“Mark To Retrieve” command downloads the message to your computer and removes it
from the server. The “Mark To

Retrieve A Copy” command downloads a copy of the

message and leaves the message on the computer. The “Mark To Delete” command deletes
the message without downloading it.

5. After you have marked the messages, click “Transfer Mail” on the Tools menu.

Every Word project you create — whether it's a personal letter, a TV sitcom script, or a thesis in
microbiology — begins and ends the same way. You start by creating a document, and you end by
saving your work. Sounds simple, but to manage your Word documents effectively, you need to know
these basics and beyond. This chapter shows you all the different ways to create a new Word
document — like starting from an existing document or adding text to a predesigned template — and
how to choose the best one for your particular project.

You'll also learn how to work faster and smarter by changing the view of your document. If you
want, you can use Word's Outline view when you're brainstorming, and then switch to Print view
when you're ready for the hard copy. This chapter gets you up and running with these fundamental
tools so you can focus on the important stuff — your words.

The first time you launch Word after installation, the program asks you to confirm your name and
initials. This isn't Microsoft's nefarious plan to pin you down: Word uses this information to identify
documents that you create and modify. Word uses your initials to mark your edits when you review
and add comments to Word documents that other people send to you (Section 16.3).

You have three primary ways to fire up Word, so use whichever method you find quickest:

¢ Start Menu: The Start button in the lower-left corner of your screen gives you access to all

programs on your PC — Word included. To start Word, choose Start — All Programs —
Microsoft Office — Microsoft Office Word.
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i the bottom of your screen (just to '
Quick Toolbar: The Quick Launch toolbar at the
e ¢ Ll“;:l“ ml:.; is a great place to gtart programs you use frequcntly,‘ Mium !
right of the that you'll be using Word a lot, 50 it usually installs the Word icon i gy |
Quick I:mch toolbar. To start using Word, just click the “W" icon, and voilé! |

e r——————— 1
i |

|

|

|
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2.6.1 Creating a New Document | |
When Word without opening an existing document, the program gives you an empy
mmm};l.“l?yﬂw‘measerm put words on the page, then type away. Sooner or later though, you|

want to start another new document. Word gives you three ways to do so:
Quick Access
toolbar

A Tale of Twe Cities |
by Charles Dichane

Sk ths Pirst—Ascalled to Iifs
1

The Puried

It wms the besy of times, 1t wes the werst of simes, it wes the sgw of

windam, it wes the age of foolishoeas, 1t was the spoch of belief, it was
*he enpseh af taevedulity, ¢ uan rhe seasan of Tight. 1t ves Fhe seamen

Figure 1.1: When you start Word 2007 for the first time, it may look a little top-heavy. The ribbon
takes up more real estate than the old menus and toolbars. This change may not matter if you have a
nice big monitor. But, if you want to reclaim some of that space, you can hide the ribbon by double-
clicking the active tab. Later, when you need to see the ribbon commands, just click a tab.

e Creating a new blank document: When you’re preparing a simple document — like a two-
page essay, a note for the babysitter, or a press release — a plain, unadorned page is fine. Or,
when you’re just brainstorming and you're not sure how you want the final document to look
like, you probably want to start with a blank slate or use one of Word's templates (more on |
that in a moment) to provide structure for your text. '

e Creating a document from an existing document: For letters, resumes, and other
documents that require more formatting, why reinvent the wheel? You can save time by
using an existing document as a starting point (Section 1.2.2). When you have a letter format
that you like, you can use it over and over by editing the contents. '

e Creating a document from a template (Section 1.2.3): Use a template when you need a
professional design for a complex document, like a newsletter, a contract, or minutes of a
meeting. Templates are a lot like forms — the margins, formatting, and graphics are already
in place. All you have to do is fill in your text. !
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2.7.1 Get your Data into Excel

First, you need to input your data into Excel. This is the easy part! You
5 : may have exported the
data from elsewhere, like a piece of marketing software or a survey tool. Or maybe you’re inputting it
manually.

In the example below, in Column A, I have a list of responses to § 104 g S
marketing demonstrate ROI?’, and in Columns B, C, and D, I have mememmwml’o &dm
‘Does your company have a formal sales and marketing agreement?’ For example, Column C, Row 2
illustrates that 49 per cent of people who have an SLA (service level agreement), also, say that
inbound marketing demonstrated ROI.

2.7.2 Choose a Type of Chart/Graph to Create

In Excel, you have plenty of choices for charts and graphs to create. (For help figuring out which
type of chart/graph is best for visualising your data, check out our free ebook, How to Use Data
Visualization to Win Over Your Audience.)

The data I'm working with will look best in a bar graph, so let’s pursue making that one. To
make a bar graph, highlight the data and include the titles of the X and Y axis. Go to the “Insert” tab,
click under “Charts”, click on “Column”, and choose the graph you wish. In this example, I will be
picking the first 2-D Column choice — just because I prefer it over the 3-D look.
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2.7.3 Switch Axes, if Necessary
If you want to switch what appears on the X and Y axis, right-click on the bar graph, click
“Select Data” and click “Switch Row/Cqumn
2 ¥ ;--. - :_":--.A. ':_&;—#'::— ) .- "
hlhd-ﬁ't:ﬂm i d'::
Ot 4 0t ko ™

) rw-\

o
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l Yes- Iribound mavie Sy demorsty sted ROU

- W it me 0 8.4 | Mo Tboursd markrtng @t ot demorayste £
Condd ot er e ot caudote A1

.'
:

I

:‘f 2.7.4 Adjust your Labels and Legends, if Desired

To change the layout of the labelling and legend, click on the bar graph, then click on the
“Layout™ tab, Here you can choose what layout you prefer for the chart title axis titles and legend.

\ In my example, I clicked on “Chart Title” and selected “Above Chart”. To format the X axis title,

""S I clicked on “Axis Titles” “Primary Horizontal Axis Title” and “Title Below Axis”. To format the Y

- axis title, I clicked on “Axis Titles”, “Primary Vertical Axis Title” and chose “Rotated Title”. To

change the placement of the legend, click on “Legend” on the “Layout” tab and choose your preferred
location.
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2.7.5 Change the Y axis Measurement Options, if Desired
TomngemeWOfMSlmnemShownmﬂwYuh,ri

£ ght-click on the Y axis percentages,
and click on “Format Axis”. Here you can decide if you want to display units located on the “Axis
.ms'-ub,m-lfyouwanttochangewhethermeYaxiulmpereuntngudeochml places or to
0 decimal places.
= fomatavs "~ 118 e
1
$ j Yeos- Inl m Axis Options 40%
3 No-Inba | rier Wine: @ ato © Bred [55 | 4
T I e @ a © i o5 o
. ke Malor it @ mup © Fued 0.4
Lne Style Mot @ am © Foed 002 HEREST Wil
‘- | ) yahues in reverse order {
e [ Logarithmic scale  Base: [0 |
||| slow and Soft Edges
Display yrits: [None 7]
30 Format [2) Show display units label on chart 1
Algrment Major tick mark type: i
Mror bekmark e [tore [5] a0 !
s abels: |
1 ® Avgratc
| © mmvag: o0 ] ]
1 © Maximum axis vaue !
: | r
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The resulting graph would be changed to look like this:

¥ Lirked to souree
resuit

formats udﬂlhlﬂﬂm&
awﬂ

i Y ‘Yes- We have
2 | Yes- Inbound marketing demonstrated ROI [
(4 Could not or did not calculate ROl

4% 0%
9% 9%,

Yes- We have aSLA  No- We don't use aSLA
Does your company have a formal sales-marketing

Formal Sales-Marketing Agreement .
Increases Probability of Inbound Marketing
Demonstrating ROI

¥ No- Inbound marketingdid not ||

demonstrate ROI

¥ Could not or did not calculste

?
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2.7.6 Reorder Data, if Desired
To sort the data so that the software choice:
column that s MOSt iMportant to you (in this cage. | 1o " oending popularity order, click on the

that » I picked Col i “Data"
click “Filter”. Then go back to Column B, click the down mw‘: :rl:] cl'iac)i: ?‘gfal:tm z“;nu‘l‘lbe’n:m

%)

it Moelaeat  fomues | Duis | Faview

ABD B B Rl
fom From From FromOther | Bxisting  Retyeqn S TOPOURE '

Access Wieb Tl'.ll SOI-II‘“‘! e Cmﬂnl m +» Edit Links b il s.ﬂ
Get External Data

| o
1' Yes- Inbound marketing demonstrated RO : '3“-45,_‘] We don't use a

3 ' No-Inbound marketing did not demonstrate RO e : s
4 Could not or did not calculate ROI 29% 3%

5 29%

6

LB : .

-54 Formal Sales-Marketing Agreement

Increases Probability of Inbound Marketing
Demonstrating ROI

323

§ Yes- Inbound marketing
demonstrated ROI

¥ No- inbound marketing did not | |
demonstrate RO

¥ Could not or did not calculate
ROI

% of Respondents

338848

m -4
Yes-We have aSLA  No-We don't use aSLA
Does your company have a formal sales-marketing agreement?

If you click on the downward arrows located at Bl and C1, you can choose to sort based on
smallest to largest or largest to smallest, depending on your preference. Here, I sorted largest to
smallest on B1. '

4]




L ¥

k& >
/

oo

{40
| Could not or did not calculate RO 29% 39%
4 No- Inbound marketing did not demonstrate ROl 9% 9%
Formal Sales-Marketing Agreement
Increases Probability of Inbound Marketing
Demonstrating ROI
¥ Yes- Inbound marketing
demonstrated RO!
B Cauld not or did not cakulate
m'l ——
® No- inbound marketing did not |
demonstrate ROI

Yes- We have aSLA  No- Wedon't use aSLA
Does your company have a formal sales-marketing agreement?

Pretty easy, right? What other Excel functions have you always wanted help with? Check out
some additional resources below for additional help using Excel and visualising your data in smart

ways.

2.8.1 Using Basic Function: Text, Math and Trig, Statistical, Date and Time,
Database, Financial, Logical

¥ AutoSum ~ @

; Recently Used ~ A T
Function [ Financial~ [

MAX v (=
T o i Y 0
1 =SUM(19.99, B9, C9:C11)
2 | | SUM(numberl, [number2], |
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#|

Figuring out formulas for calculations you want to make in Ex tedious and complicated.
pa cel can be

Fortunately, Excel hfs.an entire library of functions - or predefined formulas — you canmdtake ld‘l/lﬂnhse

of. You may be fa.mlllaf with common functions like Sum, average, product, and count, but there are

pundreds of functions in Exoel.‘ even for things like formatting text, referencing cells calculating

financial rates, and analysing statistics, e '

In this lesson, you'll learn the basics of inserti

wtilising the “AutoSum"™ and “Insert Functions” commands. You will also become familiar with how
to search and find various functions, including exploring Excel’s “Functions Library”,

2.8.2 Video: Working with Basic Functions in Excel 2010

A function is a predefined formula that performs calculations using specific values in a particular
order. One of the key benefits of functions is that they can save you time because you do not have to
write the formula yourself. Excel has hundreds of functions to assist with your calculations.

To use these functions correctly, you need to understand the different parts of a function and how
to create arguments in functions to calculate values and cell references.

The order in which you insert a function is important. Each function has a specific order — called
syntax — which must be followed in order for the function to work correctly. The basic syntax to create
a formula with a function is to insert an equals sign (=), function name (SUM, for example, is the
function name for addition), and argument. Arguments contain the information you want the formula
to calculate, such as a range of cell references.
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2.9.1 Working with Arguments

must be enclosed in parentheses. Individual values or cell references inside

parentheses are separated by either colons or commas.

e Colons create a reference to a range of cells.
For example, =AVERAGE(E19:E23) would calculate the average of the cell ﬂlngc Elg

through E23.

Commas separate individual values, cell references, and cell ranges in parentheses. If ther,
is more than one argument, you must separate each argument by a comma.

For example, =COUNT(C6:C14,C19:C23,C28) will count all the cells in the three

arguments that are included in parentheses.

2.9.2 To Create a Basic Function in Excel
1. Select the cell where the answer will appear (F15, for example).
2. Type the equals sign (“="), then enter the function name (“SUM”, for example).
$12.20 8-Aug 11-Aug
$7.33 11-Aug.

$61.00

$15.95.
$5.87
$8.83

$13.54  $27.08 22-Jul 29-Jul

$40.26|  $80.52 12-Sep 17-Sep

$4.20 $42.00 6-Sep 12-Sep

_$6.19|  $74.28 6-Sep 12-Sep

» 53‘_20 $48.00 : 5'539. 12-Sep

| $3.40(  $17.00 . 6-Sep 12-Sep

$4.10)  $32.80 6-Sep 12-Sep

$12.20]  $61.00 8-Aug 11-Aug

| $7.33 $36.65] = BAug 11-Aug

|=sumirs:Fia) R Sty weuaee
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4, Press “Enter”, and the result will appear.
$450.85

Excel will not always tell you if your function contains
your functions. To learn how to do this, read the

Excel Formulas tutorial,

an error, so it's up to you to check all of
“Double-Check Your Formulas” lesson from our

2.9.3 Using AutoSum to Select Common Functions

The “AutoSum™ command allows you to automatically return the results for a of cells f
common functions like “SUM” and “AVERAGE?”. range s for

1. Select the cell where the answer will appear (E24, for example).
2. Click the “Home” tab.

3. In the “Editing” group, click the “AutoSum” drop-down arrow and select the function you
want (“Average”, for example).

m
3 X Sum
Format ||. . I8
i e
Eﬁﬂ Count Numbers
Max
K|  Mn
More Fundions...

4. A formula will appear in E24, the selected cell. If logically placed, AutoSum will select your
cells for you. Otherwise, you will

P P o e g™

AVERAGE(numberl, [nun!her).], w) |

5. Press “Enter”, and the result will appear.
The “AutoSum” command can, also, be accessed from the “Formulas™ tab.

45



Information Technology in Business Management -]l
“AutoSum” command. To use

[ 44
You can also use the “Alt™ + “=" keyboard shortcut instead of the
this shortcut, hold down the “Alt” key and then press the equals sign (“=").

T T e S CONRRBS

1. Open an existing Excel 2010 workbook. If you want, you can use this example.
2. Create a function that contains more than one argument.
Use “AutoSum” to insert a function. If you are using the example, insert the “MAX"”

function in cell E15 to find the highest-priced supply.
" If you are using the example, find the

4. Insert a function from the “Functions Library™.
“pRODUCT” function (multiply) to calculate the “Unit Quantity” times the “Unit Price” in
cells F19 through F23. : i

5. Use the “Insert Function” command to search and explore functions.

To insert a Function from the Function Library
1. Select the cell where the answer will appear (I6, for example).

2. Click the “Formulas” tab.
From the “Function Library” group, select the function category you want. In this example,

we'll choose “Date & Time”.
Select the desired function from the “Date & Time” drop-down menu. We'll choose the

“NETWORKDAYS” function to count the days between the order date and receive date in

our worksheet.

F @880

Insert  AutoSum Recently Finandal Logical Text
ml’l - Used - v

(1]

Date&| Lookup & Math  More
hv u“!m' &Tﬂﬂ" mem'

=
Office Supply Order Log  Jul-Sep 2010

' 9 |Binder Clips (Multi)
Pens (Blue) - KLH78902

Returns the number of whole workdays

11 Pens (Red) KLH78904 I b
12 Highligher Pens (Yellow)  STA73298 :
13 sticky Notes JUG198430 © Press F1 for more help.
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5. The “Function Arguments” dialog box will appear. Insert the cursor in the first field, then
enter or select the cell(s) you want (Gé, for

example).

17-sep[iKDAYS(G6)
17-Sep

T@::"

i Start_date is a serial date number that represents the start date.
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7. Click “OK”, and the result will appear. Our results show that it took five days to receive the

order.
17-Sep 5

12-Sep

ent because it allows you to search for a function by

g a category to peruse. The Insert

The Insert function command is conveni
argument for a function,

typing a description of what you're looking for or by selectin
easily enter or select more than one

function command can, also, be used to

2.11.1 Using the Insert Function Command
In this example, we want to find a function that will count the total number of supplies listed in

the Office Supply Order Log. The basic “COUNT” function only counts cells with numbers; we want
to count the cells in the “Office Supply” column, which uses text. Therefore, we'll need to find a

formula that counts cells with text.
1. Select the cell where the answer will appear (A27, for example).
2. Click on the “Formulas” tab, then select the “Insert Function” command.

Text Date & Lookup & Math More
Time ~ Reference ~ & Trig v Functions ~

ﬂ L
| & M k ."L""..'.‘ G = 7 -:. .':::'_’ | r — ey

1

v

AutoSum Recently Financial Logical

- ; Used ~ X
, _ Function Library _ :
| Insert Function (Shift+F3) | & s
I ot the formuia in the current cen [ B S b e
| by choosing functions and editing
(1| the arguments.
!ii o -.- T ‘-f:_ ) ) ) : : ; T
| @ Press F1 for more help. 38290 | 10 boxes 5
S ronubanar E— Vo) T ) 9 cartanc ‘

3. The “Insert Function” dialog box will appear.
4. Type a description of the function you are searching for, then click “Go” (“Count cells with
text”, for example). You can, also, search by selecting a category. _
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3 pinder Clips (Muiti)

10 pens (Blue)

1 ‘pens (Red)

12 Highligher Pens (Yellow)

e P &)

Type a brief description of
the function you are
searching for and click Go

l__._n.i-——

Review the recommended
results and select a function.

Then click OK.

6. The “Function Arguments” dialog box will appear. Insert the cursor in the first field, then
enter or select the cell(s) you want (A6:A14, for example).
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7. Tnsert the cursor in the next field, then enter or select t:hc cell(s) you want (A19:A23, il‘
example). You can continue to add additional arguments if needed.

-

v
% 3
L S
|
r . Select cell range for next argument.
s : Click OK when finished.

Velue2: valuelvaluzZ,... are 1 to 255 arguments representing the v
you want 1o count. Yalues can be any type of information.

8. Click “OK”, and the result will appear. Our results show that 14 total supplies we . an
from our log. ‘

2.11.2 Using Advance Functions: Use of VLOOKUP/HLOOKUP

Ons, you may want to try a more a
xcel’s VLOOKUP Function for more
eck out an Excel formulas tutorial. -

“YLOOKUP”, You can check How to Use E
wamtolumcvcnmorcaboutﬁmctions, ch

‘—. 5 R i o o
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2.12.1 Sorting Data

men sorting data, it’s important to first decide if you want the sort to apply to the entire
worksheet or just a cell range.
o Sort sheet organises all of the data in your worksheet by one column. Related information

across each row is kept together when the sort is applied. In the example below, the Contact
Name column (column A) has been sorted to display the names in alphabetical order.

A : b c

1 Customer Contact List

2 BRILLING ADDRESS PHONE ADD

3 |Bell, William 2201 Treasure Court  206-555-2303  wbell@bishopresearch.com

4 |Dean, Hank 3034 Foggy Wharf 308-555-1050 hdean@venturebrewing.com

s |Figgis, Mallory 3520 Sleepy Hearth Dr 425-555-5370  malloryf@archerproperties.com
g JFinn, Jake 1407 Dusty Fawn Ln  605-555-6435 jake@adventureoutfitters.com

7 |Xinkade, Chris 1028 Quiet Dale Rd  443-555-4942  chris kinkade@placervilleins.com
g |Lawson, Miranda | 5316 Colonial Pkwy  575-555-9255 mlawson@massairlines.com

g [Reyes, Felicia 8544 Lazy Bluff Ave  316-555-3256 felida@everlypublishing.com

10 | Sebastian, Lil 9060 Easy Evening Ln 207-555-7225  lil@knopeequestrian.com

11 |Silva, Vivica 8595 Thunder Brook  360-555-4289  vivica@rileygardensupply.com
12 | Stark. Katie 971 Cinder Butterfly St 603-555-2460  katie stark@ariarealestate.com
13 | Torrance, Jill 3160 Amber Gate Rd  605-555-4495  jtorrance@overlookinn.com

14 }Yuen, Phillip 5108 Crystal Gate Blvd 913-555-5928  yuenp@corepharmaceuticals.com

e Sort range sorts the data in a range of cells, which can be helpful when working with a sheet
that contains several tables.Sorting a range will not affect other content on the worksheet.

“:3‘33-.-.-&‘-”.—
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To Sort a Sheet
In our example, we'll sort a T-shirt order alphabetically by Last Name (column C).
1. Selecta cell in the column you want to sort by. In out example, we select cell C2.
| 2t ' B L E
Lml Name Payment Method
~ MacDonald _lorge
4 i __.._Yaron_ syl M
" 108 Melissa White Small ~ DebitCard
105 Nathan Albee Medium iChagk.
105 Sidney  Kely Medum  |Check
110 Gabriel DelToro  Medium |Cash
110 Kris Ackerman Large Money Order
2. Select the Data tab on the Ribbon, then click the Ascending cmmandﬂ;toSmAmz, o
the Descending command & to Sort Z to A. In our example, we'll click the Ascending
command.
22
£
/¥
P
R _ .
3. The worksheet will be sorted by the selected column. In our example, the worksheet is now
sorted by the last name.
O e -
B Homeroom #  First Name Lost Name 1-Shirt Size
w i Ackerman Money Ord
@) NN, Nathan ~ Albee Check
A3 08 . Sumantha ~ Bell Medium Check
5 110 ___qut___'_ Benson ~ Medium - Money Order
é 105 Chrisfiana _ Chen  Medm  Cash
7 110 Gabrel - Delforo __Medum  Cosh
8| 220A Brigd ~ EHlison Small - Cash
PR o, 0 EHores 020202 ZXloge 00
10 220-8 Tyrese Hanlon X-Large Debit Card
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To Sort a Range

In our example, we'll select a separate table § .
T-shirts that were ordered on different dates, n our T-shirt order form to sort the number of

1. Select the cell range you want to sort. In our example, we'll select cell range A13:817

SRx2C . A fime

Tota! Ordens By Date

Date

2.12.2 Filtering Data (Auto Filter, Advanced Filter)

Auto filter

Advanced filter

1. Enter the criteria shown below on the worksheet.
AR B | ¢ | D E
1 [LastName Sales  Country Quarter
2 USA Qtrd
3 |
4] W
S_JI.ntName sales Country Quarter

6 |Smith $16,753.00 UK Qtr 3

7 |Johnson |$14,808.00 USA  Qtr4 ,

8 |williams  $10,644.00 UK Qtr2

9 |Jones $1,390.00 USA  Qtr3
10 Brown $4,865.00.USA  Qur4
11 Williams $12,438.00 UK Qtr1
12 Johnson  $9,339.00UK  Qtr2

13 |Smith $18,919.00 USA  Qtr3
14 |Jones $9,213.00 USA  atr4
15 |Jones $7.433.00 UK atr1
16 Brown $3,255.00 USA  Qtr2 Pt >
7 Williams  $14,867.00 USA  Qtr3

18 Wwilliams  $19,302.00 UK Qtra

19 |Smith $9,698.00 USA  Qtrl
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2. Click any single cell inside the data st
- S Ontthlhub,mtheSonmdFlhﬂmchckAdvmd. ;

¢
' ']
£
'
=
Nmme@ﬁmwwpyymrﬁlmred&mwmmhuﬁmmdcﬁquymiqmm
only (if your data set contains duplicates).
Result:
|
1
_Country Quarter
: 00 USA Qtr4 el v
}[Brown  $4,865.00USA  Qtr4
ss,nsmus.u _ atra
No rocket science so far. We can achieve the same result with the normal filter. We need the
Advanced Filter for Or Criteria.
e
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or Criteria
To display the sales in the USA in Qtr 4 or in the UK in Qtr 1, execute the following steps:
6. Enter the criteria shown below on the worksheet. .
7. On the Data tab, in the Sort and Filter group, click Advanced . o
to range A1:D3 (blue). and adjust the Criteria range
8. Click OK.
Action
© Eiter the list, inplace
() Cgpy to another location
ustrange:  [sassi0s0 [
Criteriarange: |Sheet1/sAS1:0$3 (i)
Copy to: L i ..__.+
I unique gecords only
Result: '
I
1 |lastName Sales
2]
i
o .
5 _|Last Name Sales
7[iohnson _|$14,808.00 USA  atra
10iBrown  $4,865.00 USA  Qtr4
11 |Williams | $12,438.00 UK ‘Qtri
_Iﬂ_'l.lor_les | $9,213.00USA  Qtr4 |
15/jones | $7433.00UK  Qtrl
o0
Formula as Criteria :
To display the sales in the USA in Qtr 4 greater than $10.000 or in the UK in Qtr (?) execute
the following steps:

9. Enter the criteria (+ formula) shown below on the worksheet.

10.  On the Data tab, in the sort and Filter group, click Advanced, and adjust the Criteria range to
range A1:E3 (blue).
11.  Click OK. -
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@ Fiter the list, in-place '
) Cgpy to another location

strange:  [SASO819
iteriarange: | Sheet1isAsLisesd (68
Copy to: | e -

() Urique records orly

oy W
‘Country Quarter
UsA atr4

Johnson
Williams

| UK Qtr1

|$14,808.00 USA  Qtrd - |

1$12438.00 UK |atr1

| 15 |Jones

| $740200uk  jotrx | |

1 )

1

2.12.3 Data Validation
Data Validation Example

Inthisexample.werestrietmerstoeuterawholenumberbctwe'mom 10.

W 8 F
l - - . - - -— | il
How many glasses of akchohol do you drink per day? | & I
3 : ¥ _ipifvy
Create Data Validation Rule
¥

2. Select cell C2.

On the Data tab, in the Data Tools group, click Data Validation.

To create the data validation rule, execute the following steps:

56
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On the setting tab:
3. In the Allow list, click Whole number.
. In the Data list, click between.
5. Enter the Minimum and Maximum values.

e =

Settings
Vabdation criteria
How: -
ey
= ul
Minimum:
o [
i secn B SR sl S
[10 =
Dwmwmanmwmumm
Lo J[ cona ]
Data Validation Result
1. Select cell C2.
BTN L Ll

How maay ghases of kthohol do you drink per day?

2. Try to enter a number higher than 10.

o Are you drinking too much?

| Ry ]| Concel |
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2.12.4 What-if Analysis (using data table/scenarios)

Creating Subtotals and Grand Totals

If you have a list of invoices in Excel, and you want that list to show a total .for each month and
for the year, most people would use the SUM function to total each month. But, if you try to do that
for the year you will end up totalling both the invoices and the m_onthly t_otals, unless you move the
monthly totals to a separate column. Another common approach lsmwnlfafomuhﬂmatpom to
each monthly total and adds them up. The beauty of the SUBTOTAL function is that you can add up
the whole column and yet it will ignore the other SUBTOTALS that it finds.

Here is an example of how it works.
Let's say that I want a subtotal in cell C4 that adds up the three cells above it. I wou{d enter the
TOTAL(9,C1:C3)” in cell C4. As you would expect, the “C1:C3” designates the
mggm Cl1 through C3. I'll talk about the 9 later.
Now, to put a grand total on line 11, I can use the formula “= SUBTOTAL (9, C1:C10)". Notice
that the range doesn’t exclude cells C4 and C9 where the subtotals are, The subtotal function

automatically excludes these amounts.

In a small example like this, it may not seem worth the trouble of trying to remember how to
enter the subtotal function. But, in a large spreadsheet with hundreds to even thousands of lines, you
can save a lot of time and effort by not having to track down the individual ranges that would be
needed to use the more familiar SUM function. Next, 1 will show you how, in many cases, you can
have Excel insert the subtotals and grand total automatically, so you don’t have to remember how to
enter the subtotal function yourself.

Now, back to the mysterious “9” that I said I would explain. The subtotal function has 11
different options that can be chosen. Among other things, it can add, multiply, count, or average, the
entries in a given range of cells. The 9 simply tells Excel to add or sum the cells in the range. For a
complete list of options, search for SUBTOTAL FUNCTION in Excel’s help.

Pivot Table/chart
i B T e 08 ST ST SR

Banana Beans Broccoli Carrots Mango Orange Grand Total
52721 14433 17953 8106 9186 8680 131713
33775 12407 3767 19929 94745
36094 680 5341 9104 7388 2256 141056
39686 29905 37197 21636 8775 8887 |
40050 4390 12010

42908 5100 38436 41815 5600 21744
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To insert a pivot chat, execute the following steps”
{. Click on cell inside the pivot table.
2. Onthe Analyze tab, in the Tools group, click Pivot Chart.

SR

Show  Fields, tems, | PivotChart | OLAP  What.sr
Values Asv & Sets~ Tools ~ Analysis *

_,-_.._===___=_TOOB

Below you can find the pivot chart. This pivot chart will amaze and impress your boss.

Category ¥

%'z I||I'I.||_.u.1|].|“.|lh E:

Australa Canada France Germany New  United United
Zealand Kingdom States

Note: Any changes you make to the pivot chart are immediately reflected in the pivot table and vice versa.

Filter Pivot Chart
To filter this pivot chart, execute the following steps:

1. Use the standard filters (triangles next to Product and Country). For example, use the
Country filter to only show the total amount of each product exported to the United States.
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Category *

Sum of Amount

100000 gl
90000 Product v
80000 mAppie
m mBanana
50000 _ u Beans
m | . m Brocook
= iinl =
loong P aMango

United States

Country »Y

2. Remove the Country filter.

3. Because we added the Category ﬁeldtoﬂlcl-‘ilteraren,wecanﬁlterﬁﬁspivotchm(md
pivot table) by Category. For example, use the Category filter to only show the vegetables
exported to each country.

Category v ¥
60000
50000 '
40000
Product v
30000 mBeans
20000 = Broccol
10000 II I l uQarrors
. 1 _al s mlf 1
Australia Canada France Germany New  United United
Zesland Kingdom States
Country v
Change Pivot Chart Type

Youcanchmgetoadiﬂ'ermttypeofpivotchartatanytim.

L.
2.

Select the chart.
On the design tab, in the Type group, click Change Chart Type.
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Sy .
E:
[
W
rcmge Chart Type

All Charts .

™ Recent
| Templates

Column

Gl
[
X Line
E

e e e e e R T P} SR S e SRSty T Rty
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Beans
Country _
mAustralia
W Canada
w France
B Germany
m New Zeaand
Product
Goal Seek/solver
e =(Goal Seek

When using the goal seek function, Excel varies the value in a cell that you specify until a
formula that is dependent on that cell returns the result you want. It is very useful for
quickly solving any formula for a single unknown value. If you’ve used the solver on a TI-
83+, the method is very similar. This example will use Excel to solve a formula for the ideal
path of a projectile.

Projectile Motion

y—y=(@E-x)tan 6=— & (1 -Ftetlizﬁ(.r—aﬁvn)r2
200
0 — launch angle
Lo — launch velocity
Xo, )0 — launch position, positive up
(a) Setup the variable names in column A. | : 4'
(b) Name cells by selecting A2:B10 and pressing Ctrl-shift-F3 (or the menu Insert, Name,
Create). Since our names in the left column, select that option. Click on one of the
empty cells in column B to see if it was named as expected.
(c) Copy/paste the image of the formula from the webpage to use for reference.
(d) Enter the formula in the cell next to the example label. Be careful with parenthesis.
Watch the colour coding to help you spot errors.

(e) Use Tools, Goal Seek to determine where (x value) a projectile will hit the ground
(y = 0) if it is shot from ‘0, 0) with a velocity of 75 ft/s. Note that if you have to run
goal seek again, the valugs are not automatically calculated. Which answer you get
depends upon the value of theta that you start with.(answers: 8.3 and 8.17 degrees) 3
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2.12.5 Researcli and Data

Meet Cane. Cane is a student enrolled in a research course. Having never done research before,
he was not sure what to expect. Shortly into the course, the professor assigned the very first
assignment. Students were to select a topic that interests them and present a question that they hoped
to answer by conducting research.

Because Cane loves hunting, he decided to do some research to discover what the average age
was that youth started hunting deer and bears. He hoped to see if there were any differences in how
young the hunters were based on the element of how dangerous each species was. For example, Cane
suspected that there would be more young hunters hunting deer than there would be hunting bears.
While Cane knew what his topic was, and he knew what question he wanted to answer, he did not
know where to begin.

In this lesson, we will learn what data analysis is and explore the different methods of collecting
data and how to analyse them.

2.12.6 Methods of Data Collection

Data analysis is a method in which data is collected and organised so that one can derive helpful
information from it. In other words, the main purpose of data analysis is to look at what the data is
trying to tell us. For example, what does the data show or do? What does the data not show or do? For
Cane, will his data show that there are more young hunters out hunting deer each year? Or, will it
shock Cane and show that more young hunters are hunting bears?

There are many different methods of collecting data. Depending on the type of research one is
conducting, they may use one or more of the following forms:

Observations: This type of data collection involves watching ot observing something or
someone. For example, Cane might observe how many people come to buy hunting licenses and note
their age. ES

Interviews: This involves talking to people. When interviewing someone, there are usually
questions asked so that the researcher can come to some sort of a conclusion. For Cane, he might ask

il
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hunters.
Surveys: A survey is a series of questions. An example of survey questions might be:

1. Were you satisfied with your experience today?

2. Will you shop at our store again?

Using free presentation software to create or edit presentations doesn’t have to mean cutting
corners on features or using a clunky interface that doesn't work the way it should.

These free presentation software programs have just as much to offer as Microsoft PowerPoint,
but you won't have to pay a dime for them.

Many similar features include easy to use slide design and transition effects, tabbed interfaces,
spelicheck, free templates, and much more. You really can create exactly the presentation you want
with these free programs.

You may, also, want to consider a free online presentation maker, which will allow you to work
on your PowerPoint from anywhere. If you're only looking to view or present a slideshow, and not
make any changes, consider using the free PowerPoint Viewer.

You can add more interest to your presentation with presentation templates and presentation
backgrounds.

You may also want to consider downloading a free alternative to Microsoft Office, many of them
include presentation creators as well as free word processors and free spreadsheet programs.

Creating A Presentation With Minimum 20 Slides with a Script Presenting in Different Views

2.13.1 Kingsoft Presentation
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If you're looking for an et:sy to use presentation program byt still with
tation is a perfect fit. It’s easy to get started -and even beginners wil? lgl:f'

It has a clean and organised layout with a tabbed
without being too cluttered or confusing to use.

interface and tons of presentation tools, all

Kingsoft Presentation can run a spelicheck across all the slides, works with ‘

2.13.2 OpenOffice Impress
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OpenOffice Impress is chock-full of all the features you need to build a great presentation. A
simple wizard can walk you through setting up the initial backgrounds, slide design, and transition
effects if you’d rather not start with a blank canvas.

There are extra features that include drawing tools, animation, text effects, and multiple monitor
support.

There are free templates and extensions available as well as automatic spellcheck and support for
macros.

Inserting Pictures, Videos, Creating Animation Effects on them

Animations can be used in Powerpoint to add a bit of flair to your presentations. You can animate
both text or objects on a page as well as create transitions between pages. First you’ll need to select the
object that you want to animate, then select an animation from the “Animations” tab and modify the
animation settings to your liking. Slide transitions are handled similarly from the “Transitions™ tab.
Powerpoint also supports the addition of animated images or videos to a slide via the “Insert” tab.

Open Powerpoint. These methods will also work with similar free software, like Google Slides or
OpenOffice Impress, but the button locations and options may vary.
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Click on the object you would like to animate. You click on text or images to animate,
e To select a whole text box, click on the border of the text box. Powerpoint automatically
distinguishes text separated by a paragraph or bullet break.
e If your Powerpoint has no objects to animate, you will need to add some.

Go to the “Animations” tab. This is located in the top Menu bar and will display a variety of
animation options and controls.

Select the animation you would like. These are split into four categories: entrances, exits,
emphasis, and paths. The most recently selected animation will be set to that object and added to the
animation pane. : ;

e You can click through the animations to see a demonstration and view more animations by
scrolling with the arrows on the right of the ani_matiom box.

e Entrance animations will change how an object enters the page.

e Exit animations will change how an object leaves the page.

e Emphasis animations will add movement or highlights to bring attention to an object.

e Paths determine a course of movement for an object on the page.

Click “Add Animation” to add extra animations to an object. Select an animation effect from the
drop-down. If you attempt to add an animation without first clicking “Add Animation” it will replace
the existing animation instead of adding to it.

e This step can be repeated multiple times to add as many animations to an object as you like.

Click “Animation pane” (optional). This button is located in the “Advanced Animation™ section
of the “Animation” toolbar and will bring up a panel displaying your selected animations on the right.

e This can be a useful tool for staying organised when working with multiple animations

Select an activation option for the animation. Select one of the options from the “Start” drop-
down in the “Timing” section on the right of the Animations toolbar: “On mouse click”, “After
previous™ or “With previous”.

® “On Mouse Click” will hold the animatiom until you click the mouse.

e “After Previous” will automatically start the animation after any previous animation

(or when the slide appears if there are no other animations).
e “With Previous” will play the animation at the same time as the previous animation on that
slide. : .
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2.13.3 Slide Transitions, Timed Presentations

slideDog

siftsiad e, |

SlideDog is a bit different than these other presentation programs because it'

: _ s built for presenting
files rather than building and presenting. ’

It works by creating a playlist of media like video, images, PDFs, and PowerPoint files. The
presenter can easily add all of these files to a playlist and then use SlideDog to display it in front of an
audience.

Tools are available to present files to people over a browser so they can access your presentation
from anywhere, as well as a live chat and poll feature. '

This is a great way to organise a presentation if you want something more than a simple
presentation.

2.13.4 Rehearsal of Presentation

Express Points Presentation Software
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ability to add audio. ‘
You can Maudioﬁmanﬁaophmcdhmlyhnoasﬁde.openhﬁmﬂ PowerPoint’s PPTX
files, and autosave presentation files as often as every minute.

Apple Keynote

i

Apple Keynote is a free presentation software app for iOS MMMMMfmm
collaboration, so that the whole team can easily work together on creating that next presentation.

There are themes, slide transitions, object effects, text

Charts are used to display sequence of _______ data.
Most of the data which is Microsoft Office program is .

Q.1. Fillin the blanks:
1. is an important tool for writing and sending a personalised letter.
2. Microsoft Office Word can provide and option to save your work.
3. Editing a file covers which basic areas.
4. VLOOKUP stands for
5.
6.

Q.2. True or False:
The master view consists of slides handout and note view.

Editing a Word file means making changes in the text contained in a file.
Bookmark name has to be with special symbols and can contain numbers.
A placeholder appears in our drive.

ol o o o
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Match the following: iﬂ
5 Group A Group B
I. Datasave (a) MS Excel
2. Solver (b) Presentations
3. Goal seek (¢) Iteration tool
4. Word processing | (d) Save As
5. Inserting images (¢) Horizontal lookup
6. HLOOKUP
Write short notes:
Explain the saving of documents,
Explain the creating of documents,
Write the step of editing the documents.
Explain the use of SmartArt.
Explain the basic functions.
Write the step of creating a chart.
Explain the creating of slides.

Long answers questions:

What is the use of mail tool? Write the step for using mail?
What is data analysis?

Write the step for creating presentation.

What is SmartArt?

Write the step of creating and saving documents.

L
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Email, Internet and its
Applications

3.1.1 Writing Professional Email
1. Begin with a Greeting: Always open your email with a greeting, such as “Dear Lillian’
your relationship with the reader is formal, use their family name (e.g., “Dear Mrs. Pr

If the relationship is more casual, you can simply say, “Hi Kelly”. If you don’t know
name of the person you are writing to, use: “To whom it may concern™ or “De
Sir/Madam”.
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3. Thank the Recipient: If you are replying to a clit;.m‘s e W .
of thanks. For example, if someone has a question lnqul “y;:;" should begin with a line
“Thank you for contacting ABC Company”. If someone has l‘epliedm;q’my » JOU GiI By,
be sure to say, “Thank you for your prompt reply” or one of your emails,

Thanking the reader puts him orheratense,anditwillmakeyouaplfoa;rmt;rg bahct: o
3. State your Purpose: If you are starting the email communication, it may bep:nlpc;mible to

include a line of thanks. Instead, begin by stati b 5
o enquire about ...” or “I am writing in l::t‘arenu:es t?ur + For example, “1 am writing
Make your purpose clear early-on in the email, and then : 3
email. Remember, people want to read emails quickly, wmok:;“;t:wthcm":: text h:f-t your
clear. You'll also need to pay careful attention to grammar, spelling and P“ﬂct:;js and
you present a professional image of yourself and your company. e ingsy

4. Add your Closing Remarks: Before you end your email, it’s polite to thank your reader
one more time and add some polite closing remarks. You might start with “Thank you for
your patience and co-operation” or “Thank you for your consideration” and then follow-up
with, “If you have any questions or concerns, don’t hesitate to let me know” and “I look
forward to hearing from you”.

5. End with a Closing: The last step is to include an appropriate closing with your name.
“Best regards”, “Sincerely”, and “Thank you” are all professional. Avoid closings such as
“Best wishes™ or “Cheers” unless you are good friends with the reader. Finally, before you
hit the send button, review and spell check your email one more time to make sure it’s truly

perfect!

3.1.2 Creating Digitally Signed Documents

The digital equivalent of a handwritten signature or stamped seal, but offering far more inherent
security, a digital signature is intended to solve the problem of tampering and impersonation in digital
communications. Digital signatures can provide the added assurances of evidence to origin, identity
and status of an electronic document, transaction or message, as well as acknowledging informed
consent by the signer.

In many countries, including the United States, digital signatures have the same legal significance
as the more traditional forms of signed documents. The United States Government Printing Office
publishes electronic versions of the budget, public and private laws, and congressional bills with
digital signatures.

How Digital Signatures Work

Digital signatures are based on public key cryptography, also known as asymmetric cryptography.

Using a public key algorithm such as RSA, one can generate two keys that are maﬂmnaticelly linked:
one private and one public. To create a digital signature, signing software (§uch as an ml program)
creates a one-way hash of the electronic data to be signed. The private key is then used to encrypt the

hash. The encrypted hash — along with other information, such as the hashing algorithm — is the digital -

signature, The reason for encrypting the hash instead of the entire message or document is that a hash
function can convert.an arbitrary input into a fixed length value, which is usually much shorter. This

saves time since hashing is much faster than signing. .
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The value of the hash is unique to the hashed data. Any change in the dﬂot;.:v?o ch?mg
deleting a single character, results in a different value. This attribute enables others h::hm the
Mwofﬂwdnmbymhgﬂwsiwm‘spublickeytodecryptthehash.lfthccbo:nrpt.?:l Mache,
a second computed hash of the same data, it proves that the data ha?n‘t.changed since it was signed, ¢
the two hashes don't match, the data has either been tampered with in some wm,'(xrm:g-ny)‘,,the
signature was created with a private key that doesn't correspond to the public key presented by th,
signer (authentication). -

A digital signature can be used with any kind of message — whether itme:ncry]_xeda-;'[o!__
simply so the receiver can be sure of the sender's identity .and t!:at the message arrived mtac‘t. _D’B'fll
signatures make it difficult for the signer to deny having slg-m'ad sqmethmg‘(nor?-rewdmnon) &
assuming their private key has not been compromised — as the dIM signature is unique to both the
document and the signer, and it binds them together. A digital certificate, an electrmlc.documft that
contains the digital signature of the certificate-issuing authority, binds together a public key with an
identity and can be used to verify a public key belongs to a particular person or entity. :
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Configuring Outlook, Creating And Managing Profile in Outlook, Sending and Receiving Emails
through Outlook

Understand the difference between POP and IMAP email services. There are two ways that email
can be delivered to your email client: POP (Post Office Protocol) and IMAP (Internet Message Access
Protocol). POP is the older method of transferring email messages, and works by downloading new
messages to your client and then deleting them from the server. IMAP was designed to allow you to

check email from multiple devices, as messages and organisations are synced between all of the clients

you use.

® There is really no practical reason to use POP if IMAP is available. IMAP is more stable,

more secure, and allows you to check your email from your computer, phone, and laptop

without losing any messages. _ J
® Most email services allow you to use IMAP, though some may charge for it. Gmail, Y;

Outlook.com (Hotmail), AOL, and most service providers allow for IMAP.
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. mail). Most emaij servi

IMAP functions without makmg any Chﬂ:l:lg 3 ces allow YOu to access

you will need to manually enabje IMAP, - The major €Xception to this i Gmail, \vh:l:

o Log onto the Gmail website and click the

“Forwarding and POP/IMAP” tah,. Selsct “Eﬂﬂblebmom"ije:::c;i:tﬁugg’" and then click the
: ave "
Ouuoo!‘l‘ wg?tl yc:; 0 an IMAP emi seryice, you'll be able to e g
your e@; n 00 and On all of your other devices, Any check, Organise, and
ill be reflected in your other email clients.Click the “File” tab. In the mﬂ you make in Outlook
Account” button. section, click the “+Add
Select “Manual setup or additional server types™. This will allow

You to enter i
Note: If you’re using Gmail or Hotmai] SRl accome.

password in the “E-Mail Account” section of the Add New pgocrr . ChieF YOUT email address and

personalised email s that are fo
identically and use the same text and graphics, Only ? : message rmatted

are personalised. Mail merge — unlike broadcasting a message to a group of people — makes each
recipient of the message the sole recipient.

i
:
é’f
E
:
B

There are three documents involved in creating email messages using the mail merge process: '

¢ Your main document: This document is your email message, it contains text and graphics ’
(alogo or image, for example) that are identical for each version of the merged document.

Your mailing list: This document contains the data that is used to populate information on

the letter. Your mailing list has names, for example, and your main document is the email

message that will be addressed to the names in your list. ' >

Your merged document: This document is a combination of the main document and the

mailing list. Mail merge pulls the formation from the mailing list and puts it in your main

document, resulting in a personalised, merged document for each person on the mailing list.

3.3.1 Prepare Your Main Document

Type the body of the email message you want to send to everymeiandbeff!:eymbegh:If
you're telling people about an upcoming event, for example, include the name, date, time, and location
of the event. Those event details are important for everyone to know.
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m"'l
OntheMnilingatnb in the Start Mail M : Q

’ WFM.ChoooeStartMmlMu-ge>E.m.ﬂMm“
INSERT _ DESIGN pA'Ge LAYOUT asrmﬂ

B B B B

§d_ect Edit Highlight Addres|
<ipients ~ Recipient List | Merge Fields  Block
B Letters :
{8 E-mail Messages fs i
Enyelopes...
B Labels..
= Directory '
Normal Word Document
W Step-by-Step Mail Merge Wizard,.

3.3.2 Set up Your Mailing List

3.3.3 Link Your Mailing List to Your Email Message

Now it’s time to choose your recipients from a data source (an address list). Make sure your data
source has a column for email addresses and that there's an email address formhpersouyou’re

® On the Mailings tab, in the Start Mail Merge group, choose Select Recipients, and then

® Do one of the following:

° Ifyoudon’thaveamailingHst,mooseT‘ypcaNewListandmteone;m 3
. Ifymumaningﬁstismmﬂxcelspreadsheet,mAmdata_base.oranom«typeoﬁm
file, choose Use an Existing List. Then browse to your list and choose Open; or ;
® Ifyou’re using your Outlook contacts, choose Choose from Outlook Contacts.

® Choose File > Save as.

e Inﬁ:cFﬂenamebox,typeaﬁlename,apdmcnchooseSave.
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3,3.45

dit your Mailing List L

email message. lf'yo.u want to send emails A tep 4: Add
w0 *) ¢ steps under Edit your mailing list. only to certain people s dont

list, US¢ S
Choose Edit Recipient List.
INSERT  DESIGN  PAGE LAYOUT mmg

& Ce| 32

el E ghlight Add
Merge~ Recipients ~JRecipient List] Merge Fields Blocr?
Start Mail Merge

5. Check the names of the people who you want should recei email
Chock e e o e e shoud ecive your e messge
Mail Merge Recipients

- =S A

| | Data Source [~ |Last Name w | First Name
EventMailingListx.. [¥ Anderson Nancy
EventMailingListx.. [~  Basalik Evan
EventMailingListx.. [¥ Carbonati Cyril

EventMailingList x.
EventMailingListx.. | Dixon Andrew
EventMailingListx.. | Dow Jane

You also can sort or filter the list to make it easier to find names and addresses.

13,5 Add Personalised Content to the Email Message

Personalise each email message by adding a person’s name and address. The best practice for
adding these details is to insert merge fields in your main document.

1. On the Mailings tab, in the Write and Insert Fields group, choose Address Block.

oUT REFERENCES = MAILINGS REVIEW_ VIE}

N [3 Rules ~

- ' Q& Match Fields
Highlight |Address|Greeting Insert Merge [ Update Labels
erge Fields| Block | Line Field

Write & Insert Fields

2 In the Insert Address Block dialog box, choose a format for the recipient's name as it will

appear in the email.
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Specify address elements
._ﬁWsthm

[¥] nsert postal address:
) Never indude the country/reglon in the address
¢ Always include the country/region in the address
@ Only Include the country/region if different than:
|United States

[¥] Format address according to the destination country/re

3. Choose OK to insert the merge field.
4. Inthe Write and Insert group, choose Greeting Line.

OUT  REFERENCES | MAILNGS | REVIEW VI
J‘g? Eir l%!i' I:} F!U'IS"
f f = : - S & Match Fields
f Highlight Address|Greetingfinsert Merge .. 4
lerge Fields  Block | Line | Field~ Ly
Wﬂte & Insert Fields

o

\l.:&!.‘.h

5. In the Insert Greeting Line dialog box, choose the format you want to use.
6. Choose OK to insert the merge field.
7. Choose File > Save to preserve your email.

rrey

Bulk email software is software that is used to send emails in large quantities.
Bulk email software usually refers to stand-alone software, while there are bulk email sending
web based services as well.

Computer worms that spread themselves via email are an example of bulk email software,
sometimes referred to as a mass mailer. Such worms usually (but not necessarily) send spoofed

“From” headers.

3.4.1 Types of Software

Most bulk email software programs are hosted by third party companies who sell access to their
system. Customers pay per send or at a fixed monthly rate to have their own user account from which
they can manage their contacts and send out email campaigns. Generally, the advantage of this type of
program is the reliability of the third party vendor and their application. Some bulk email software
programs are self-hosted. The customer buys a license or‘develops their own program and then hosts

‘ = _— S
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5.1 Understanding Internet Technology
35

It is the largest network in the world that connects hundreds of t L
: networks all over the world. ousands of individual

e The popular term for the internet is the “information highway”,

o Rather than moving through geographical sPace, it moves your ideas ang information
through cyberspace — the space of electronic movement of ideas and information,

¢ Noone owns it.

It has no formal management organisation,

e Asitwas originally developed by the Department of defense, the lack of centralisation made
it less vulnerable to wartime or terrorist attacks.

o To access the internet, an existing netwrkneedstopuyasmallregistraﬁmfeemﬂagreeto
certain standards based on the TCP/[p (Transmission

Control Protocol/Internet Protocol) .
3.5.2 The Uses of the Internet
e Send email messages.
¢ Send (upload) or receive (download) files between computers.
o Participate in discussion groups, such as mailing lists and newsgroups.
¢ Surfing the web.
353 What is Web?

® The Web (World Wide Web)

: particular website are organised around and link
back to, is called the site’s home page.
354 How to Access the Internet?

® Many schools and businesses have direct access to the internet using special high-speed
Communication lines and equipment, ‘

® Students and employees can access through the organisation’s local area netwarks (LAN) or
through their own 5
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S5 TRt rvine mv‘::: (:::)pa-m;nent connection to the internet that sejjs
e A commercial organisa

: ibers.
connections to WSS E. o Microsof

network, AT&T Networks.

Access the Web? .
3.5.6 How to o connection, then you need specml software called a '
e Once you have your I‘.I
ﬁ:mm w:e sed 1 connect you to remote computers, open and transfer fjey iy,
§
text and images. ,
are specialised programs. . ]
: Exwwmmwgb _brmspec . Netscape Navigator (Navigator) and Internet Explorer,

3.5.7 Client/Server Structure of the Web |
o Web is a collection of files that reside on computers, called Web servers, that are Jocapeg

4

overﬂmeworldmdareoonnectedtoachoﬂmthroughthemtemcﬁ 3
e When you use your onternet connection to become part of the Web, your computer besgme.

a Web client in a worldwide client/server network. ok :
e Each part of the address is a number ranging from 0 to 255, and part is separated §

the previous part by period. =
e For example, 106.29.242.17

3.5.8 IP Addressing 3
e The combination of the four IP address parts provides 4.2 billion possible

256 x 256 x 256). g
This number seemed adequate until 1998. 3
Members of various internet task forces are working to develop an alternate addressi
system that will accommodate the projected growth. b
e However, all of their working solutions require extensive hardware and software
throughout the internet.

3.5.9 Domain Name Addressing R
® Most web browsers do not use the IP address to locate websites and individual pages,

e They use domain name addressing. Re

® A domain name is a unique name associated with a specific IP address by a program

runs on an internet host computer. ‘

® This program, which coordinates the IP addresses and domain names for all compt
attached to it, is called DNS (Domain Name System ) software. i

® The host computer that runs this software is called a domain name server.
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4,510 Uniform Resource Locatorg

ThclpmandﬂwdomainnameMim
However, they do not indicate
computer. Where a we

The name of the file
HTTP

The transfer protocol is the set of ry

computer to another on the internet. i computers use to moye files from ope
The most common transfer protocol used i :

(HTTP). O the internet is the Hypertext Transfer Progogg|

3.5.11 How to Find Information on the Web?

A number of Search tools have been

: : ilable to you on certain websites
that provide search services to help you find information, : i
Examples:

¢ Yahoo —  www.yahoo.com
<+ Excite —> Www.excite.com
<+ Lycos - www.lycos.com

%+ AltaVista = www/alta-vista.com
@

MSN WebSearch —» www.search.msn.com
You can find information by two basic means.

Search by Topic and Search by keywords.

Some search services offer both methods, others only one.
Yahoo offers both.

Search by Topic.
You can navigate through topic lists.
Search by keyword.
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3.6.1 Internet

This is the worldwide network of computers accessible to anyone who knows their internet
Protocol (IP) address — the IP address is a unique set of numbers (such as 209.33.27.100) that defines
the computers locationMost will have accessed a computer using a name such as
http://www.hcidata.com. Before this named computer can be accessed, the name needs to be resolved
(translated) into an IP address. To do this, your browser (for example Netscape or Internet Explorer)
will access a Domain Name Server (DNS) computer to look-up the name and return an IP address - or
issue an error message to indicate that the name was not found. Once your browser has the IP address
it can access the remote computer. The actual server (the computer that serves up the webpages) does
not reside behind a firewall — if it did, it would be an Extranet. It may implement security at a
directory level so that access is via a username and password, but otherwise all the information is
accessible. To see typical security, have a look at a sample secure directory — the username is Dr and

the password is Who (both username and password are case sensitive).

3.6.2 Intranet

This is a network that is not available to the world outside of the Intranet. If the Intranet network
is connected to the internet, the Intranet will reside behind a firewall and, if it allows access from the
internet, will be an Extranet. The firewall helps to control access between the Intranet and internet to
permit access to the Intranet only to people who are members of the same company or organisation.

In its simplest form, an Intranet can be set up on a networked PC without any PC on the network
having access via the Intranet network to the internet. |

For example, consider an office with a few PCs and a few printers all networked together. The
network would not be connected to the outside world. On one of the drives of one of the PCs there
would be a directory of webpages that comprise the Intranet. Other PCs on the network could access
this Intranet by pointing their browser (Netscape or Internet Explorer) to this directory — for example
U:\inet\index.htm.

From then onwards they would navigate around the Intranet in the same way as they would get
around the internet. :

3.6.3 Extranet

An Extranet is actually an Intranet that is partially accessible to authorised outsiders. The actual
server (the computer that serves up the webpages) will reside behind a firewall. The firewall helps to
control access between the Intranet and internet permitting access to the Intranet only to people who
are suitably authorised. The level of access can be set to different levels for individuals or groups of
outside users. The access can be based on a username and password or an IP address (a unique set of
numbers such as 209.33.27.100 that defines the computer that the user is on).
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are several different types of computer

e size as well as their purpose. networks can be ch h
o size of a network can be expressed by the s
Tasmn[mpanofmenetwork.Nmmmg;wm“c"“‘heyoccupymmemof

a‘?‘wk room t0 millions of devices spread acrosg the cnt‘;r ;l!::behm from a handfy) of devices within
o of the different networks based on size are:
personal area network, or PAN
Local area network, or LAN
Metropolitan area network, or MAN
Wide area network, or WAN

haWever, serve a very particular purpose. Some of the different networks based on their mh' _

e Storage area network, or SAN
o Enterprise private network, or EPN
o Virtual private network, or VPN

37.1 Hub

A simple network device that connects other devices to the network and sends packets to all the
jevices connected to it. A hub is basically a multiport repeater that connects multiple wires coming
from different branches. Hubs cannot filter data, so data packets are sent to all connected devices. As
they do mot have intelligence to find out best path for data packets, it leads to inefficiencies and
wastage. Hub cannot read MAC address, therefore it will transfer the data to all the connected devices

and only correct device/s will copy the data.
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3.7.2 Bridge

Local Area Networks (LANs) working

idge i ications processor that connects two Loca! . i
on tthns;?; mu;?ﬂﬁdgc is a repeater with add on functionality of filtering contents by raeding
the MAC address of source and destination.

Manufacturing Database Server

Corporate LAN Segment Manufacturing Segment

3.7.3 Routers

A device that receives and analysis packets and then routes them towards their destination. In
Some cases, a router will send a packet to another router, in other cases, it will send it directly to -..;;
destination. Routers are required on internet to read [P addresses. If [P addresses is of our nets
then the packet is transferred to our network, else the packet is transferred to our network, else the
packet is forwarded to next router on internet. Router is used to connect the networks. '
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374 IP addresses

Every device that communicates on the internet, whether it is a personal computer
smartphone, or anything else, is assigned a unique identifying number called an [P (Intu:;eta ::::OB
address. Historically, the IP address standard used has been [Pv4 (version 4), which has the format of four
pumbers between 0 to 255 separated by a period. E.g., let’

s say the domain Wikipedi
address of 107.23.196.166. The IPv4 standard has limit of 4.29):49,67,296 (2%) i,:?;::g mﬁ ::nu;
billion possible addresses. However, [Pv6 standard, which is currently being phased in, is formatted as
eigt groups of  four  hexadecimal digits separated by colon, such as
2001:0db8:8523:0042:1000:8a2€:0370:7334. The IPv6 standard has a limit of 3.4 x 10% possible
addresses.

38.1 Local Area Network (LAN)

A Local Area Network (LAN) is a network that is restricted to smaller physical areas, e.g., a local
office, school, or house. Approximately, all current LANs whether wired or wireless are based on
Ethernet. On a ‘Local Area Network’ data transfer speeds are higher than WAN and MAN that can
extend to a 10.0 Mbps (Ethernet network) and 1.0 Gbps (Gigabit Ethernet).

LAN networks can be implemented in multiple ways, for example, twisted pair cables and a
wireless Wi-Fi with the IEEE 802.11 standard can be used for this purpose. One end of the twisted
pair cable is plugged into switches using “RJ-45 connectors”, whereas the other end is plugged to a
computer or in another network. All new routers use the b/g/n IEEE 802.11 standards. The “b” and “g”
Operate in the 2.4 GHz spectrum, and “n” operates in 2.4 and 5.0 GHz which allows better
performance and less interference.

Computers and servers (provides services to other computers like printi.n%., file storage mi:l
sharing) can connect to each other via cables or wirelessly in a same LAN. Wireless access
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conjunction with wired network is made possible by Wireless Access Point (WAP). Devices wjy,
WAP functionality provide a bridge between computers and networks. A WAP is able to conneg
hundreds or even more of wireless users to a network. Servers in a LAN are mostly connected by ,
wire since it is still the fastest medium for network communication. But for workstations (
laptops, etc.) wireless medium is a more suitable choice, since at SOM® point it is difficult ang
expensive to add new workstations into an existing system already having complex network wiring,

Token Ring and Fiber Distributed Data Interface (FDDI)

With Ethernet, “Token Ring” and “Fiber Distributed Data Interface (FDDI)"” are also considereq
the major “Local Area Network” technologies. In Token Ring network all computers are connected ip,
a ring or star topology for prevention of data collision and with a data transfer rates of either 4 or |¢
megabits per second by IEEE 802.5 standard version. In FDDI for data transmission, optic fibre are

used that extend the range of a LAN up to 200km and supports thousands of user.
New to networking? See this beginner’s course at Udemy.com
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3.8.2 Wide Area Network (WAN)

Wide Area Network is a computer network that covers relatively larger geographical area such as
vides a solution to companies or organisations operating from

a state, province or country. It pro
th each other for sharing and managing

distant geographical locations who want to communicate wi

central data or for general communication.

WAN is made up of two or more Local Area Networks (LANs) or Metropolitan Area Networks
(MANSs) that are interconnected with each other, thus users and computers in one location can
communicate with users and computers in other locations.

In “Wide Area Network”, computers are connected through public networks, such as the
inks or leased lines. The “Internet” is the largest

telephone systems, fiber optic cables, and satellite |

WAN in a world. WANs are mostly private and are built for 2 particular organisation by “Internet
Service Providers (ISPs)” which connects the LAN of the organisation to the internet. WANs are
frequently built using expensive leased lines where with each end of the leased line a router is

connected to extend the network capability across sites. For low cost solutions, WAP is also built
using a “circuit switching” or “packet switching” methods.

3.8.3 Metropolitan Area Network (MAN)

A Metropolitan Area Network (MAN) is a network that connects two or more COMPpULETS,
communicating devices or networks in a single network that has geographic area larger than that
covered by even a large “Local Area Network”, but smaller than the region covered by a “Wide Area
Network”. MANs are mostly built for cities or towns to provide a high data connection and usually

owned by a single large organisation.

A Metropolitan Area Networks bridges a number of
links which act as a backbone, and provides services similar to what
provide to Wide Area Networks and the internet. .

Major technologies used in MAN networks are “Asynchronous Transfer Mode (ATM)”, “Fiber

Distributed Data Interface (FDDI)” and “Switched Multi-megabit Data Service (SMDS, a connection-
less service)”. In most of the areas, these technologies are used to replace the simple “Ethernet” based

“Local Area Networks” with a fiber optical
Internet Service Provider (ISP)
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191 pomain Name Registration, Hosting Basics

people take things for granted particularly when it comes to domain
Jhat domain names are, but only.a few know all of the details that are
ot become evident until a domain name is required for a website. A domain name is essentially a
Jebsite address. The entire web address is called as the Uniform Resource Locator or the URL., If you
want to use a domain name, it should be registered with a registry. A top-level domain name (TLD)
Mwmemd part of a domain extension or the domain name. The domain names should be at
jeast two characters long and should not be more than 63 characters maximum, excluding the top-level
domain. The characters can incorporate any combination of letters, hyphens or numbers.

N names. Most people know
involved. These typically do

19.2 Domain Name Registration

When a domain name is registered or recorded, it is controlled by an extensive database full of
other domain names. This is called a registry. The registrars are the ones who make domain name
registration and management viable, The individual registering a domain name is referred to as the
registrant.

For the first time buyers, the process of Domain name registration could be a bit confusing. If you
don't have any idea about the process, then you will find a number of terms that you need to worry
about. However, we are here to help you out to tackle the problems that you might face. With the
information given below, you will get some idea on how to register domain names. Perhaps you could

even successfully find one with the “tips” provided while avoiding the inconvenience that can
sometimes come during the process of registration.

3.9.3 Name Servers

Have you ever heard about name server? Name servers are concerned to a service that works on
servers belonging to a web hosting company that hosts the account that the domain name will direct to.
Each domain name on the internet has to point to an IP address. However, each IP address can have
many domain names on it. Subscribing the name servers of the hosting company you have for the
domain name you are registering allows the big DNS name servers on the internet know where to
obtain the hosting account for the domain name in question. It would not be possible for any computer
W find any webpage, without this service. This is all generally done very fast.
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3.10.1 Concept of E-Commerce and M-Commerce
Transacting or faculltatmg business on the internet is called e-commerce. E-commerce is short for

“electronic commerce.” Popular examples of e-commerce revolve around buying and selling onlip,,

But, the e-commerce universe contains other types of activities as well. Any form of busines
transaction conducted electronically is e-commerce. Here are some examples of e-commerce:

Online Shopping
Buying and selling goods on the internet is one of the most popular examples of e-commerce,

Sellers create storefronts that are the online equivalents of retail outlets. Buyers browse ang
purchase products with mouse clicks. Though Amazon.com is not the pioneer of online shopping, it js
arguably the most famous online shopping destination.

Electronic Payments

When you are buying goods online, there needs to be a mechanism to pay online too. That is
where payment processors and payment gateways come into the picture, Electronic payments reduce
the inefficiency associated with writing and mailing checks. It also does away with many of the safety
issues that arise due to payment made in currency notes.

Online Auctions :

When you think online auction, you think eBay. Physical auctions predate online auctions, but
the internet made auctions accessible to a large number of buyers and sellers.’Online auctions are an
efficient mechanism for price discovery. Many buyers find the auction shopping mechanism much
interesting than regular storefront shopping.

Internet Banking

Today, it is possible for you to perform the entire gamut of banking operations without visiting a
physical bank branch. Interfacing of websites with bank accounts, and by extension credit cards, was

the biggest driver of e-commerce.

Online Ticketing

Air tickets, movie tickets, train tickets, play tickets, tickets to sporting events, and just about any
kind of tickets can be booked online.

Online ticketing does away with the need to queue up at ticket counters.

3.10.2 Types of E-commerce

1. Business-to-Business (B2B): It is a form of electronic commerce in which products or
services are sold from a firm to another firm. It is performed in much higher volumes than
B2C. For Example: Intel is selling micro-processors to Dell or Reebok is selling shoes to

Flipkart are the examples of B2B. Websites examples: shop2gether.com, Quill.com. 3
2. Business-to-Consumer (B2C): It is a form of electronic commerce in which products or
services are sold from a firm directly to consumers. For Example: Dell is selling a laptop to
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or Flipkart is selling Reebok shoes to a ¢ I
E‘:mples: p g R ustomer are the examples of B2C, Website

Consumer-to-Business (C2B): It is a form of electron; gy

services are sold from a consumer to a firm. For Exm];e?o{'@u:ﬁl;‘ﬂ which products or
prakashan or a programmer is offering his freelance programmin w‘g a book to Manan
Website examples: guru.com. 8 services to a company,

5, Business-to-Government: B2G model is a variant of B2B model. bsites |
by governments to trade and exchange information with vano:ls m umgreﬁz:d |

Such websites are accredited by the government and provide a medi g p
application forms to the government. . um to business to submit

6. Electronic Governance or E-governance: E-governance is the applicati i 2
and communication technology (ICT) for delivering govemm;ll:p ﬁﬂ;ﬂ ffm 0;'
information, communication transactions, integrations of various stand-alone systems and
services  between government-to-citizen (G2C), Government-to-business  (G2B),
government-to-government (G2G), government-to-employees (G2E) as well as back ofﬁc;
processes and interactions within the entire government framework. Through e-governance,
government services will be made available to citizens in a convenient, efficient and
transparent manner. The three main target groups that can be distinguished in governance
concepts are government, citizens and business/interest group. In e-governance, there are no
distinct boundaries. |

3.10.3 Business models of e-commerce: models based on transaction party(B2B, 1
B2C,B2G, C2B, C2C, E-Governance)

E-commerce can be classified based on the type of participants in the transaction:

o Business-to-business (B2B): B2B e-commerce transactions are those where both the
transacting parties are businesses, e.g., manufacturers, traders, retailers, and the like.

&st vs. B2C E-Commerce
r |

] i
-___-'..__——_-—_-—— i
! ; {
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e Business-to-consumer (B2C): When businesses sell el

called B2C e-commerce. o *

e Consumer-to-consumer (C2C): Some of the earliest transactions in the global economie
system involved barter — a type of C2C transaction. But, C2C transactions were virtually
non-existent in recent times, until the advent of e-commerce. Auction sites are a goog
example of C2C e-commerce.

3.10.4 Benefits of E-commerce B S
the fact that it eliminates limitations of time

Thepinmrybmeﬂtsofe-oonnnercemvolveammd 3 :
and geographical distance. In the process, e-commerce usually streamlines operations and lowers costs,

3.10.5 What is M-commerce?

M-commerce (stands for mobile commerce) is the buying and selling of goods and scr\'ir_fcs *
through wireless handheld devices (**) such as cellular telephone and persmnl digital assistants
(PDAs). In other words, it's a complete online shopping experience, but with all the convenience of

being I tablet. Known as next-generation e-commerce, Im-CommErce enables users to
oy g -1 The emerging technology behind m-

access the internet without needing to find a place to plug in. .
commerce, which is based on the Wireless Application Protocol (WAP), has made far greater strides
in Europe, where mobile devices equipped with web-ready micro-browsers are much more common

than in the US.
(*),(**): :
e Wireless handheld device: The emerging technology behind m-commerce is based on the

Wireless Application Protocol (WAP). Handheld devices that can be used wireless are:

cellular telephone, personal digital assistants (PDAs), tablet, phablet, etc.

Goods and Services applicable so far: Mobile Money Transfer, Mobile ATM, Mobile

ticketing, Mobile vouchers, coupons and loyalty cards, Content purchase and delivery,

Location-based services, Information services, Mobile banking, Mobile brokerage, Auctions,

Mobile browsing, Mobile purchase, In-application mobile phone payments, Mobile

marketing and advertising.

e SimiCart is the best Magento mobile app builder so we can help store owners and customers
feel comfortable when shopping by mobile app in m-commerce era.

e M-commerce: M-commerce is short for “mobile commerce.” The rapid penetration of
mobile devices with internet access has opened new avenues of e-commerce for retailers.

3.11.1 Business Revenue Model

Advertising Revenue: A website that offers its users contents, services, and/or products also
provides a forum for advertisements and receives fees from advertisers. Websites, those are able to
attract the greatest viewership are able to charge higher advertising rates. Number of people visiting 8
website is known as Hits, Website examples: Yahoo.com, Google.com
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: A website that offers its users :
bocﬂpﬁ““ Revenue \ . contents or services c} £ b
s to same or all of it offerings. They may charge monthy/anmual subseription foe The
e ents offered by such site, must be a high value added, premium offering that neither is readil
ﬂilabl ", clsewhere nor easily replicated. Examples: Consumerrepots.org, Dalalstreet.com y
8

Transaction Fee Revenue: A company receives a fee for executing a transaction, For

vides an online auction marketplacfandreceivuamuwmfeeﬁom i
ﬁ;ll’s“; ful in selling the item. Website examples: eBay, sharekhan.com g g

Gales Revenue: Companies derwe revenue by selling goods, information or i
austomers. The percentage of people visiting the site and buy something is known as S e
Website examples: Amazon. Flipkart. Covernon

Affiliate Revenue: Sites that steer business to an “affiliate” receive a referral fee or -
the revenue from any resulting sales. Website example: Mypoints. ' g

Electronic Fund Transfer is popularly known EFT and represents the way business can receive
direct deposits of all payments from the financial institution to the company’s bank account. Once the
user signs up, money comes to his directly and sooner than ever before. EFT is fast, safe and means
that the money will be confirmed in user’s bank account quicker than if he had to wait for the mail,
deposit the cheque and wait for the funds to become available. EFT moves money between accounts
faster and paperless way.

Automated Teller Machines (ATM’s): Consumers can do their banking without assistance of a
human being. You can get cash or make deposits or pay bills or transfer funds from one account to
another electronically. These machines are used with Card and PIN (Personal Identification Number).

Point-of-sale (POS) Transactions: Debit or EFT cards can be used when shopping to allow the
transfer of funds from consumer’s account to the merchant’s. To pay for a purchase, the consumer
presents a card instead of cash. Money is taken out of the consumer’s account and put into the
merchant’s account electronically.

Preauthorised Transfers: This is a method c;f automatically depositing to or withdrawing funds
from an individual’s account, when the account holder authorises the bank or a third party to do so.

Phone Transfer: Consumers can transfer funds from one account to another by mobile phone.

EDI (Electronic Data Interchange) is the transfer of data from one computer system directly to
another by standardised message formatting, without the need for human intervention. EDI permits
multiple companies — possibly in different countries — to exchange documents electronically, Data can
- exchanged through serial links and peer-to-peer networks, though most exchanges currently rely on
the internet for connectivity. '

An EDI messages contains a string of data elements, each of which represents a sinémlar fact,
such as a price, product model number, and so on, separated by delimiter. The entire string is called a
data segment. One or more data segments framed by a header and trailer form a transaction set, which
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often consists of why,
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is the EDI unit of transmission (equivalent to a message). A transaction set
would usually be contained in a typical business document or form.
: i adhere to the same set of

When sending an EDI documnt,bothpnltluortmdmgpammmust .
rules. These standards define where and how the information from the document will be found.
Translation software processes the information differently for sent and received messages ang
performs a complete audit of each steps to ensure information is sent o received in EDI fm:mat. When
the translator on the receiving computer reads a document, it knows thmwﬁnd}hebuyscompmy
name, order number, purchase items and price, for example. This information 1s then sent to the
receiver’s order entry system without necessitating manual order entry.

EDI applies to documents such as purchase orders, invoices, shipping notices and commission
sales reports, as well as other important or classified information. For example, an insurance company
can verify that an applicant has a driver’s licence through an EDI exchange.

EDI is primarily used by large companies to have a uniform processing system, m"““?
efficiency. Cost, speed, accuracy and efficiency are the major benefits of EDL The system is
expensive to implement and usually requires help from a consultant that specialises in the field.

Using EDI systems eliminates the need — and therefore cost—toprint.. ﬁle,_store, postandremm
paper documents. The goal is to get rid of paper and have everyone working with the same invoice so
that information is processed and read easily. :

Automating paper based tasks improves data quality, and transactions are exf:hnnged within
seconds or minutes instead of days or weeks. EDI frees up staff time to work on more important tasks,
Business-critical data is sent on time and tracked in real-time by automating the transfer of data among
applications across a supply chain.

Different EDI standards address the needs of specific industries or regions or other specifications.
ANSI(American National Standard Institute) standards are used in the U.S. And EDIFACT (Electronic
Data Interchange for Administration, Commerce and Transport) standards are used outside U.S.

Advantages:
Direct Advantages
e Cost-cutting: On stationary and staff.
e Elimination of Errors: Because there is no data entry of an order.
e Less time is required for placing an order.
o Fast Response of order processing and status of order.
.

Accurate Invoicing: No data entry of invoice at both the end. Invoice can be matched with

order automatically.
¢ EDI Payment: Payment can be matched with relevant invoices.
Indirect Advantages:
e Better cash flow
® Reduced stock holding
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down the i
and also introduce§ errors. Instead, EDI documents o ﬂ:;ocessmg of t::e documents,
appropriate application on the receiver’s computer (e.2. the O lsmnght Wshs;o n::;
and processing can begin immediately. A typical manual process | g A
paper and people involvement: ooks like this, with lots of

ne—L

e > g

al s

Buyer enters Invoice YDy
into internal eystem = .
Faxes or Malls

The EDI process looks like this — no paper, no people involved:
Purchase Order

ity e

Business documents: These are any of the documents that are typically exchanged between
businesses. The most common documents exchanged via EDI are purchase orders, invoices
and advance ship notices. But, there are many, many others such as bill of lading, customs
documents, inventory documents, shipping status documents and payment documents.
Standard format: Because EDI documents must be processed by computers rather than
humans, a standard format must be used so that the computer will be able to read and
understand the documents. A standard format describes what each piece of information is
and in what format (e.g, integer, decimal, mmddyy). Without a standard format, each
company would send documents using its company specific format and, much as an English
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There are several EDI sta fo e‘ichsmndﬂfd there are many different version,
[FAﬂ:cIy;ﬂ:;t agree the specific EDI standard and version,

EDI translator ~ cither as in-house software or via <

tz;oth-.:dattl'::imlzveu.«sedl:.ythl._.nrimuml

BN T ' ocessing of documents.
jcati ble straight through Pr : :
lPPhcaﬂoM'“ 'f‘dT;“’e::u;e of EDI documents is typically betweT two  differen
i refaxetimasbminesspammwmdiﬂspﬂf“‘m- F““ﬂ:l’cf;mCompmyA
me&.w from Company B. Company A sends orders to Company B. pany A ang

Company B are business partners.

Q.1. Fillin the blanks: : :
1. A network ismldeupofﬂmeormorewuclmaf:ompomls-
€ 2 Microsoft outlook can also be used as an application.
4 3. DNS stands for
¥ 4 Wireless bridging joins two network together.
5. refer to the arrangements or physical layout of computers cables and others components on
; the network.
;‘-# Q.2. True or False:
1. DNR stands for Domain Name Registration.
2. Communications technique. -
3. DNS stands for Double Name Service.
4. LAN stands for Local Area Network.
5. Full form of email is electronic mail.
6. The m-commerce (mobile commerce) was defined in 2007.
7. MAN stands for Manual Area Network.

Q.3. Match the following:

Group A Group B
Aty (a) Buying and selling
‘2, Domain name (b) Affilate Keti Regimﬁon
3. E-commerce (¢) Domain name registrar
4, M-commerce transactions (d) Online mobile transactions

1. Different types of business model
2. Benefits of EDI
3. Routers
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05 Answer the following:

. Explain the different types of revenue and models of
2. What is the use of internet?

3. Write the steps of outlook.

4. Explain the email and the steps of email,

€-Commerce.
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e Threats can cause harm to the computer system and the network.

4.1.1 Types of Threats

Virus

Spam

Physical Threats
Hacking

Phishi

R
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EIP”" the following:

{, Virus

Ad“:';mpum's virus attaches itself to the program.

1. Wmhnicaltﬁms,ammpmuﬁnnismtbinghnmewofmﬁmmdga_

2, In wﬁmntomodifymcwayacompmumandﬂmwhlchiscbﬁwww
from one computer to another.

3. Virus can copy itself to other computers,

Disadvantages:
| Even they can steal some information.

9. They slow down your computer.
3, They can crash our computer or delete our file.
4‘ Some of the applications won'’t start.

Measures to be taken to prevent virus:
|, Certified and secured protection should be used or purchased.
2 Scanning the system should be done regularly. _
3. Beware of downloading applications from sites, and also from the attachments of the emails.
2. Spam
Advantages:

1. Spammers hack personal account and send false links under the appearance of a user or
trusted contact such as friend and family.

2. Spam not only wastes people’s time with unwanted email, but it also needs lot of network
bandwidth. 5=

Disadvantages:

1. Spam also takes lot of memory.

2. Spam even wastes lots of bandwidth.

3. Spam severely damages an internet company’s reputation.
Measures to be taken to avoid spam:

I. Never disclose your email address on any website,

2. We should avoid opening spam email and spam massages.
3. Use a disposable email address.

3. Physical Threats

1. Physical threats is that which can be fire, vandalism, earthquake, flood, etc.

2. Physical threats cause damage to physical parts of computers or any hardware.
4. Hacking

Advantages:

1. Hacking refers to the practice of modifying computers software and hardware which is
performed by a hacker to achieve a goal.
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4.2.2 Measuring IT Risk
Explain the term Measuring IT Risk

o —

Technology In Business %
[ 04 Information s _

; rs System or network,
2. Hacking is nothing but to identify the weak point in compute

ining access of
3. Hacking is done to explain the weakness of computers system by gaining access of it
Disadvantages:

" H‘d‘h&ﬁNMmumahybmﬁngmumybymmorfummeL&eewLm
2. Hacking tool is used by hacker to steal information and passwo

3. Hacking can violate people’s privacy.

Mm“hhkentopnvntshacldn':

I Websites should secure their sites with digital SSL certification.
2. Strong encryption technology should be initiated.
5. Phishing

L Sanelinkint!wemailwi!laskmtoentermoreinfmﬁonlikeourﬁﬂlmnu,m
phone number, social security numbers, and credit card numbers.

2. Phishing is a way to steal our personal information. : ' -

3. ltispa'formedbysmdingoutamilwhichcmnesﬁ-omduphcatecopmofwebsngmh.
eBay, PayPal or other banking institutions.

Measures to be taken prevent phishing:

1.

Improve of the security our computers, :
2, Weslnﬂdcheckﬂlesmnoeofinfmﬁon&maincomingmaﬂ.
3. We should identify a phishing email,

4. We should check the data information in phishing.

4.1.2 Threat Management
Write a short note on Threat Management

1. lhebmeﬁtofathr&tmmgenmmisimmpabﬂnywdweasediﬁimﬂt -.

2. Ihrmmmagememswhichammmnybroughtasqbscmmces«systemappﬁmﬁm_
provide interruption finding spam and give the information.

3. Threatmanagememisaniniﬁalsteptowardssafetymmagemcnt.

; 'Iheweforsewrityofﬂueatmamgement

Itis useful to introduction related IT risk

96



G ——— %]

mation security event: The possible occurrence of a i
- !lff’ ing @ possible breach of mfomnuon. security policy or failure of =
M?msly unknown situation that may security relevant. BRacch,
[nformation security incident:
g | They give security of business information,
2. An actual or potentially advmeﬂ’ectmthemﬁtyorwmohm
™ lmp’“’ J :
The following are explained:
|. Consequences can be expressed quantitatively,
2. Consequences can range from positive to negative.
3. There can be more than one consequences from one event.

423 Risk Mitigation and Management

Risk Mitigation

Risk mitigation is the planning and developing of the process; and options and actions to en}
opportunities and reduce threat to the projects objective.
Risk Managements

1. IT is the risk managements it application of risk managements, method of information
technology in order to manager IT risk. ‘

2. Risk managements’ plan increasingly includes comp
controlling threat to its digital assets.

3. Risk management is considered as the component of wide enterprise risk managements
system.

4. Risk management is nothing but the process of i

dentifying, controlling and accessing threat
to an organisation’s capital and earning.

 Information system security is the
information system.
® The information system deals with:
1. The elements of security
2. Security program
3. Security controls
Explain the following:
L Security Program: The very first achievement of management program and security is the
data information,
2. Security Management Responsibilities:
Write security managements’ responsibilities.

process to protect the data and information from the

-
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(8) The risk managements for the business are safety of risk is necessities.
(b) Determining the objective, scope, polices, etc.
3. Security Controls:
There are two types of security.
(a) Physical control
(b) Technical logical control
Following are explained:
(a) Physical control
(1) Monitoring for interruption
(i) Environmental control
(iii) Protecting the boundary of the facility
(iv) Controlling a single individual access into the capability and different departments,
(b) Technical logical control
Logical controls, also called technical controls, are used to provide access to your organisation’y
data in a manner that conforms to management policies. This includes the enforcement of the

principles of least privilege and separation of duties. This article looks at both preventive logical
controls, in both hardware and software.

Write short note on Security on the Intemnet

1. Its main purpose is to set up rules and procedures to use beside attack over the internet,

2. Various methods have been used to defend the transmission of data together with encryption
and from the ground up manufacturing.

4.4.1 Network Security Risk

Explain Network Security Risk:

Network security involves the permission of access to information in a network which is
managed by the administration. '

4.4.2 Website Security Risk

Explain Website Security Risk

1. Most of the small organisations or business’ feel that they do not stand as a valued
attackers .

2. All online websites face a range of security risks and threat which is s
understood and assessed. y

Types of Security Threats:

® The have more security in the information technology they seck co-operation.
® Security can be break in four way
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website system in order to modify what users see.
3 G g private and susceptible information,
i. I“D“’“ 5s,mdma]ingorﬁ'audofprovidaaotsu»ceptﬂalcdata.

443 Website Hacking
short note on Website Hacking

write Hacking is a kind of electronic graffiti and as some other forms of damage.
;. w‘;mi: hacking is assault on the website and which can change the location

: and webpage.
3. Hacking is very different it is use by computers or any electronic material.

444 Security and Email
|, Anemail service supplier implements email safety to protect an email service.

5. Email service is recognised as the co-operative measmetlmtismedtopl‘owctthemand
" information of an email account or resource.

o E-business security is very important.

e Risk managements play an important role in protecting organisations and its ability to
perform our business mission, not just its assets.

4.5.1 Firewall Concept

1. Firewall system is network security which monitors and controls the incoming and outgoing
network traffic.

2. Firewall is the technology which emerged in 1980s.

4.5.2 Components of Firewall
1. Network Policy:

(2) Innetwork policy, there are two levels, higher level and lower level.

(b) '[‘l:lehigherIevelisdeﬁnedasthoseservicwﬂmtwiﬂbeaﬂawedm‘expliciﬂyal]awed |
from restricted network.

2. Application Gateway:
(a) Application gateway runs on the firewall software between two networks.
(b) It provides synchronisation between multiple streams for exchange of data.
4.5.3 Benefits of Firewall
L. Firewall provides good security for computers.
2. Firewall monitors outbound data traffic. :
3. Firewall allows users to actively implement policy by creating particular rules.
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framework:

Defining enterprise enlian or individuals feel safe, but they do little to Fﬂteq

|. They may make some department

enterprise as a whole. +re done in the information system.

with and changes ; .

: - t..“‘ist::':eclsr;'o)olicy documents give top dm:m mfhm;w for everyone in the company ¢ :

gt united, to departments, t0 individual employees. ‘ | _
ﬂnhﬁn;gmmp is an enterprise wide information system security policy that g ,

4. The 8

mforcadevmasabmhmmedscb&ﬂi!“-

4.6.1 PPT Methodology

Write short note on PPT Methodology
o Some of the elements are depending upon the other. '
o lswesgatmoovuagewhmﬂ:eelememsareoombu:wd. y
e Usingmemimreofthesethreepolicesmﬂymommmadc. i
1. Policy
2. People
3. Technology

Following are explained:
1. Policy:
(a) This policy is the second element to security of PPT mode.
(b) Policy includes the security of statements and security of policy.
2. People: J
(2) The people elements are various responsibilities to another people of the organisation,
(b) People are most important elements in the organisation.
3. Technology:
(a) Technology is the most important element.
(b) With the help of technology, PPT can give security and support the process.
() The technology is the operating system, the database and technology are the application
v and tool. ‘
4.6.2 Understanding the Security Framework
1. The several elements are used as four pillars of the program.

2. The use of technology, strategy and usage of business initiative and process and threat. :
3. The securing the organization documents and policy the control of the environment.
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iz India, for information security, Government of India has created g number of Jaws,
47 Typesox Real-itme Systys

in different types of Real-time System
Expl are three types of real-time system

L Deterministic System

2. Soft Real-time System

3. Hard Real-time System

dem are explalned:
1. Deterministic System:
(a) This system has pre-allocation time for every task.
(b) Each task gets executed only during those time slots.
(c) The timing behaviour is within a created range.
2. Soft Real-time System:

(2) The soft real-time system comes form non-real time system.
(b) That is some rare miss if deadlines are allowed.
(c) E.g., the control of application.

3. Hard Real-time System:

(a) All deadlines should be met in time.
(b) Hard real-time system does not miss a single deadline.

4.7.2 EDI Transaction

Explain EDI Transaction
Advantages:

1. Due to less paper work and manual work, there are less chances of error.
2. Lower maintenance and resource cost.

3. Information can be transmitted from one computer to another.
4.73 E-cash

Write short note on E-cash
=

electronic cash can be withdrawn or deposited.

The user must have e-cash software with him and an e-cash bank account from which

2. E-cash means electronic cash. E-cash is physically not present, but it is logically present

over the internet.
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ectronic find transfers are made g
3. The electronic cash can work in the same way as ¢l - Aliong
the bank.

Advantages of E-cash: , . . |

. Transfer of fund can be immediately carried out by using debit card and online y -
payments, . '

2. Users will have high privacy while doing online shopping.

Disadvantages of E-cash:

I~ A power failure is one of the reasons for loss of record. e

2. Use of debit card by unauthorised person will lead to loss o ey.

4.7.4 Security Requirements for Safe E-payments
1. Non-repudiation: Protection against customer denying the order placed and againg
merchants denying the payments made.

2. Authentication: It is the method to verify the buyers or customer identity before Payments
are authorised.

3. Privacy: Exchange ofgoéds and services and money take place in privacy.

% 4.7.5 Security Measures in International and Cross-border Financial Transactiong

\ L. While allowing cross-border financial transactions, some measures should be take.

I
2. Cross-border financial transaction is the financial arrangement which is done across z
country’s border.

A8 Thrent timbing Software i

There are many companies which created software for hunting the threats. Some of them are as
follows:

1. Extra hop network

2. Cyber eason

3. Carbon black

4. Sqml

Thisismwntammmdiﬁéthhnatmmagcmtmeamnwsmhasﬁrcwaﬂinmsim" ]
system.

-

Fill in the blanks:

EDI stands for

PPT is stands ; _
Computer virus is nothing but the type of s ;
Application gateway is also called as ,

is the process to protect the information.

VA WN -
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False:

g:u;icushshmldlnvnpditiedm

wbmmmm :

Hacking is nothing but to ‘ weak points in the -

Firewall is the technology which has emerged in 19505, T

PPT stands for people policy technology.

mmbminiﬁﬂg@wm

Match the pairs:

fie 2 Group A Group B

[ 1. peT (2) Application gateway
2. E<ash (®) Electronic cash
5. ", (c) People Policy Technology
4. Firewall (d) wll'd!tl.lling
e (&) Virus

Write short notes:

Write short note real-time applications.

Write short note on PPT.

Write short note enterprise securi

Write short note E-cash. :

Write shmmwmmnl nent

Write short note on website hacking and it i

Write short note on hunting soft e

Answer the following: :
mmmmmdm e system? :

Write short note on risk mitigation and risk
Explain the security and email? anagement?
What are the IT risk?

What are the e-business risk managements i | S

LR
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